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Copyright
This manual is copyrighted.  All rights are reserved.  No part of this manual may
be copied, reproduced, translated or reduced to any electronic medium or
machine readable form without the written consent of the copyright owner - Keith
A. Hamel.

The copyright owner  makes no warranties either express or implied with respect
to this manual or with respect to the software described in this manual, its
quality, performance, merchantability or fitness for any particular purpose.

Keith A. Hamel reserves the right to make improvements or changes in the
product described in this manual at any time and without notice.  All
specifications are subject to change without notice.

NoteWriter  Software written by Keith A. Hamel

Manual written by Keith A. Hamel
Editing and Additions by Denis Labrecque

NoteWriter Manual Version  3.0
February 1997

All Manual Contents and NoteWriter  Software
Copyright  1988 - 97  Keith A. Hamel

ALL RIGHTS RESERVED.

Published by:

Opus1music inc.

Opus 1 Music Inc.
Hillcrest R.P.O
P.O. Box #74049
Vancouver, B.C.

CANADA   V5W 1E8
(604) 321-1107

email: opusone@unixg.ubc.ca
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NoteWriter  Software License
1) Grant of License. In consideration of payment of the License fee, which is a
part of the price you paid for this product, KEITH A. HAMEL, as Licensor, grants
to you, the LICENSEE, a non-exclusive right to use and display this copy of
NoteWriter  (hereinafter the "SOFTWARE") on a single COMPUTER (i.e., with
single CPU) at a single location.  KEITH A. HAMEL reserves all rights not
expressly granted to LICENSEE.

2) Ownership of Software.  As the LICENSEE, you own the magnetic or other
physical media on which the SOFTWARE is originally or subsequently recorded
or fixed, but KEITH A. HAMEL retains title and ownership of the SOFTWARE
recorded on the original disk copy and all subsequent copies of the
SOFTWARE, regardless of the form or media in or on which the original and
other copies may exist.  This License is not a sale of the original SOFTWARE or
any copy.

3) Copy Restrictions. This SOFTWARE and the accompanying written materials
are copyrighted.  Unauthorized copying of the SOFTWARE, including
SOFTWARE that has been modified, merged, or included with other software, or
of the written materials is expressly forbidden.  You may be held legally
responsible for any copyright infringement that is caused or encouraged by your
failure to abide by the terms of this License.  This SOFTWARE product is NOT
copy protected.

4) Use Restrictions.   As the LICENSEE, you may physically transfer the
SOFTWARE from one computer to another, provided that the SOFTWARE is
used on only one computer at a time.  You may not electronically transfer the
SOFTWARE from one computer to another over a network.  You may not
distribute copies of the SOFTWARE, or accompanying written materials to
others.  You may not modify, adapt, translate, reverse engineer, decompile,
disassemble or create derivative works based on the SOFTWARE.  You may not
modify, adapt, translate or create derivative works based on the written materials
without the prior written consent of KEITH A. HAMEL.

5) Transfer Restrictions.   This SOFTWARE is licensed only to you, the
LICENSEE, and may not be transferred to anyone without the prior written
consent of KEITH A. HAMEL.  Any authorized transferee of the SOFTWARE
shall be bound by the terms and conditions of this Agreement.  In no event may
you transfer, assign, rent, lease, sell or otherwise dispose of the SOFTWARE on
a temporary or permanent basis except as expressly provided herein.

6) Termination.   This License is effective until terminated.  This License will
terminate automatically without notice from KEITH A. HAMEL if you fail to
comply with any provision of this License.  Upon termination you shall destroy
the written materials and all copies of the SOFTWARE, including modified
copies, if any.

7) Update Policy.    The software developer  may create from time to time,
updated versions of the SOFTWARE.  At its option, KEITH A. HAMEL will make
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such updates available to the LICENSEE.

8) Miscellaneous.   This Agreement is governed by the laws of the Province of
British Columbia.

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY

THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING
INSTRUCTIONS FOR USE) ARE PROVIDED "AS IS" WITHOUT WARRANTY
OF ANY KIND.  FURTHER, KEITH A. HAMEL DOES NOT WARRANT,
GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR
THE RESULTS OF THE USE, OF THE SOFTWARE OR WRITTEN MATERIALS
IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS
OR OTHERWISE.  THE ENTIRE RISK AS TO THE RESULTS AND
PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU.  IF THE
SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE YOU, AND NOT
KEITH A. HAMEL OR ITS DEALERS, DISTRIBUTORS, AGENTS OR
EMPLOYEES,  ASSUME THE ENTIRE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

Keith A. Hamel warrants to the original LICENSEE that the disk(s) on which the
SOFTWARE is recorded is free from defects in materials and workmanship under
normal use and service for a period of ninety (90) days from the date of delivery
as evidenced by a copy of the receipt.  Further, KEITH A. HAMEL hereby limits
the duration of any implied warranty on the disk to the period stated above.
Some states do not allow limitations on duration of an implied warranty, so the
above limitation may not apply to you.

KEITH A. HAMEL’s entire liability and your exclusive remedy as to the disk(s)
shall be replacement of the disk that does not meet KEITH A. HAMEL’s limited
warranty and which is returned to KEITH A. HAMEL with a copy of the receipt or
warranty.  If a failure of the disk has resulted from accident, abuse or
misapplication, KEITH A. HAMEL shall have no responsibility to replace the
disk(s) or refund the purchase price.  Any replacement disk(s) will be warranted
for the remainder of the original warranty period or thirty (30) days, whichever is
longer.Defective media returned by the LICENSEE during the warranty period
will be replaced without charge, provided that the returned product has not been
subjected to misuse, damage, or excessive wear.  Following the initial
ninety-day warranty period defective media will be replaced for a replacement
fee - contact KEITH A. HAMEL for details.

THE ABOVE  ARE THE ONLY WARRANTIES OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, THAT ARE MADE BY KEITH A. HAMEL ON THIS PRODUCT.  NO
ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY KEITH A.
HAMEL, ITS DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL
CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
WARRANTY AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR
ADVICE.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU
MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.
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NEITHER KEITH A. HAMEL NOR ANYONE ELSE WHO HAS BEEN INVOLVED
IN THE CREATION, PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL
BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL OR
INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION
AND THE LIKE) ARISING OUT OF THE USE OF OR INABILITY TO USE SUCH
PRODUCT EVEN IF KEITH A. HAMEL HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.  BECAUSE SOME PROVINCES OR
STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY
FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.
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Macintosh System Software
Macintosh system files are copyrighted programs of Apple Computer, Inc.
licensed to KEITH A. HAMEL to distribute for use only in combination with
NOTEWRITER.  Apple Software shall not be copied onto another diskette
(except for archive purposes) or into memory unless as part of the execution of
NOTEWRITER.  When NOTEWRITER has completed execution Apple Software
shall not be used by any other program.Warranty:Apple Computer, Inc. makes
no warranties, either express of implied, regarding the enclosed computer
software package, its merchantability or its fitness for any particular purpose.
the exclusion of the implied warranties is not permitted by some states.  the
above exclusion may not apply to you.  this warranty provides you with specific
legal rights.  there may be other rights that you may have which vary from state
to state.

• Apple, MacPaint, MacWrite, ImageWriter, StyleWriter, LC and LaserWriter
are registered trademarks of Apple Computer, Incorporated.

• Macintosh, Finder, Font/DA Mover, MultiFinder, LQ, Chooser and Switcher
are trademarks of Apple Computer, Incorporated.

• PostScript is a registered trademark of Adobe Systems, Incorporated.
• Sonata is a trademark of Adobe Systems, Incorporated.
• Microsoft and Word are registered trademarks of Microsoft Corporation.
• PageMaker is a trademark of Aldus Corporation.
• SuperPaint is a trademark of Silicon Beach Software, Incorporated.
• Helvetica and Times are registered trademarks of Allied Corporation.
• Linotronic is a trademark of Allied Corporation.
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About the author
NoteWriter was conceived, designed and written by Dr. Keith Hamel at the
University of British Columbia.  Dr. Hamel is an Professor of Composition at the
UBC School of Music and is Director of the UBC Computer Music Studio.  He
holds a Ph.D. in Music from Harvard University and  has written extensively for
both acoustic and electroacoustic media.  His works have been performed by
many of the finest soloists and ensembles both in Canada and abroad.  In recent
years, he has received commissions from IRCAM in Paris, Ensemble
InterContemporain, Vancouver New Music, the Elektra Women’s Choir,
clarinetist Jean-Guy Boisvert, bassoonist Jesse Read, saxophonist Julia Nolan
and pianist Douglas Finch.

As a software developer, Dr. Hamel is also the author of NoteAbility , a
comprehensive music notation program for NextStep / OpenStep computers.
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Chapter 1 - Introduction
Overview
NoteWriter is a music notation system which allows you to create
professional-quality printed scores.  The program was designed to be
as flexible as possible, in order to accommodate a wide range of
compositional styles, musical complexities and page formats.  Unlike
other notation systems, NoteWriter places you in complete control of
the final appearance of your score.  You may position any of the
available images anywhere on the page (regardless of notational
legitimacy) and freely modify the score with the interactive editing
routines and imported graphics.  The program is compatible with all
PostScript  printing devices, enabling a variety of printing qualities to
be generated from the same file. In addition, documents or fragments
of documents can be saved in Encapsulated PostScript format (EPS)
and inserted into most word processors and page layout programs.

Hardware Requirements
NoteWriter runs on all Apple  Macintosh  computers (from the
Macintosh Plus to the most recent Power Macintosh) with a minimum
of 1 Megabyte of RAM above that required by the Macintosh System
Software.

� NoteWriter versions 2.78 and higher are compatible with System 7.0 and
versions 2.85 and higher are compatible with Macintosh System 7.5.

The program supports two printing methods: Draft-quality printing
(dot matrix) on the Apple ImageWriter , LQ , StyleWriter  and
Personal LaserWriter , and Laser printing on any PostScript
printing device such as the Apple LaserWriter  or Linotronic  L300
phototypesetter.

Software Requirements
In addition to the NoteWriter software included with this manual, the
Sonata  music font from Adobe Systems, Inc. is required for
PostScript printing (i.e. high-quality printing).  If you desire high-quality
printed output, this font should be purchased and placed in your
System Folder for automatic downloading during PostScript printing.
Draft-quality printing can be done without the Sonata font on dot matrix
or laser printers.  Figures 1.1 - 1.3 show the difference in quality
between the screen display,  draft printing and PostScript printing
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(using the Sonata font.)

NoteWriter is compatible with  MultiFinder ,  System 7.0, System 7.5
and most RAM programs. If you are using a RAM programs, you
should allocate approximately 1Mbyte of RAM to ensure sufficient
working space for NoteWriter.  The program can also be used with
external  large screens displays - the maximum document window
size is 60" X 60".

System Design
The basic philosophy which underlies the design of NoteWriter is that
all aspects of all images in a music score must ultimately be
controllable by the editor.  Normally, NoteWriter will assist in the
correct placement and alignment of music images, but will not restrict
the user from constructing the score exactly the the way she or he
wants.  There are virtually no limits to the complexity or variety of
music scores which can be represented with NoteWriter.

NoteWriter is oriented towards producing a complete, unrestricted
score.  Each page of your score can be a different size and have a
different staff format if desired.  Although the normal working surface
of a page is up to 48" X 48", the page origin may be shifted, allowing a
maximum size of 96" X 96".  Up to 40 staves of any length may be
placed anywhere on the working surface.  Staves may be grouped
and braced in any combination.

NoteWriter is a graphics-oriented program  music is represented as a
complex collection of images (music and other) which are positioned
on the screen with the mouse, and associated with coordinates (or
Control Points) on the screen.  Selecting and moving the Control
Points causes the associated images to be adjusted.  Since the
system understands relatively little about the syntax of music, any
image (or group of images) may be moved or adjusted regardless of
the notational legitimacy of the result.  It is this feature which gives
NoteWriter its flexibility.  In order to aid in the accuracy with which the
score can be manipulated, NoteWriter images appear slightly
enlarged on the screen.  When printed in High-quality, the images are
automatically scaled to normal size.

Back-ups and Upgrades
Please note that only registered owners will be eligible for backups
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and upgrades.  A list of registered owners is kept by the distributor of
NoteWriter, and notices concerning upgrades will be send when
upgrades are ready for distribution.

Printing From NoteWriter
NoteWriter supports a wide variety of printers, but is primarily
designed to operate with PostScript printers.  During High-quality
printing, all images are converted into PostScript code and sent to the
printer.  This permits greater precision in the placement of images
and better appearance of graphics such as slurs and ties.  For best
results, you should use a PostScript printer in conjunction with the
Sonata font.  When using an ImageWriter, StyleWriter or
non-PostScript laser printer the score will be sent to the printer as it
appears on the screen, and the print-out will be less elegant than on a
PostScript printer.  If you are using a non-Apple PostScript printer
make sure you have placed the proper printer driver in your System
Folder and that the printer has been properly setup in the Chooser  .
In some rare cases, it may be necessary to save your NoteWriter
documents as PostScript files and download them directly to your
PostScript printer.

Chapter 1: Introduction    13

Printer Examples

Fig. 1.1: Screen Display

Fig. 1.2: Dot Matrix Output
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Fig. 1.3: Laser Printer Output
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Chapter 2 - Operating The Program
This manual assumes that the user is familiar with the Macintosh and
with standard editing procedures (e.g. pointing, clicking, and
dragging.)  For details concerning computer operation refer to your
Macintosh Owner’s Guide.

Getting Started
The disk included with this manual contains all the files necessary to
operate NoteWriter except for the Sonata music font which is required
for high-quality printing on PostScript printers.  This font must be
purchased separately and placed in your System Folder so that it can
be automatically downloaded to the laser printer or phototypesetter.
Sonata may be purchased from:

Adobe Systems Incorporated
1585 Charleston Road P.O. Box 7900
Mountain View, CA 94039-7900
http://www.adobe.com

Hard Drive Installation
The NoteWriter disk you received is a Key Disk and is copy
protected.  The Key Disk can always be used to launch the copy of
NoteWriter on the original disk or to allow copies of NoteWriter
installed on hard drives to be launched.  In addition, a program called
NWAuthorizer is included on the Key Disk.  This application allows a
copy of NoteWriter to be authorized on a hard drive so that you can
run the program without the Key Disk.  NWAuthorizer allows 1 copy of
NoteWriter to be authorized on your hard drive, and allows 2
additional authorizations in case your installed copy of NoteWriter is
accidentally erased.  NWAuthorizer may also be used to de-authorize
copies of NoteWriter that are no longer being used.  (Remember to
de-authorize your installed copy of NoteWriter before re-initializing or
replacing your hard drive.)

� NWAuthorizer can only be run from the original Key Disk.

To install NoteWriter on your hard drive:

1) Insert your Key Disk in your main floppy drive.

Chapter 2: Operating The Program    17

2) Drag a copy of NoteWriter 2.87 from the Key Disk onto your hard
drive.

3) Launch the NWAuthorizer program (on your Key Disk)
4) Read the instructions and click the Continue button.
5) The total number of authorizations will be displayed.  Click the

Authorize button and locate the copy of NoteWriter that you want
authorized (i.e. the one you just placed on your hard drive.)

! A common error made by users is to authorize the copy of NoteWriter
that is on the floppy disk rather than the copy of NoteWriter that you
have placed on the hard drive.  Make sure you have located the correct
copy of NoteWriter!

6) The program will inform you whether or not the authorization was
successful.

7) Put your Key Disk away in a safe place.

If you have purchased the Sonata font, drag the Sonata screen fonts
and the Sonata laser font (called Sonat) into your System Folder.

Font Requirements
If you plan to print documents from NoteWriter, you should ensure
that the Sonata font has been placed in the System Folder before
launching NoteWriter.  During printing, NoteWriter will automatically
download the Sonata font if it is correctly installed in the System
folder.  Optionally, you can download the font manually with the
LaserWriter Utility program.

� If you get regular characters instead of music symbols when you print
your score, then the Sonata font was not downloaded to the printer
during printing and you may have to use a utility (i.e. LaserWriter
Utility) to manually download the Sonata font to the printer.  After
manual downloading, the font will reside in the printer until it is turned
off.

NoteWriter Icons
There are six desk top icons associated with NoteWriter: one
application icon, one document icon, one preferences icon, one
library icon and one icon for each of the additional file formats
supported by NoteWriter.
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Fig. 2.1: NoteWriter Icons

The PostScript and Paint icons are used for exporting musical
excerpts to other applications.  These files are created by NoteWriter,
but the data they contain cannot be read back into the program.
Normally, scores are saved as NoteWriter documents.  If you wish to
save files in  PostScript or Paint format, you should also save the file
as a NoteWriter document (i.e. NoteWriter format) so that you are
able to re-edit the file.  The Paint format is included for historical
purposes - a picture can also be performed by taking a screen-snap
of the computer from the Finder (Command-Shift-3).

Preferences
The Save Preferences menu item saves the current positions of all
windows (including the Keyboard and Show Score windows) and the
current PostScript settings in a preference file (called nw-pref).
When NoteWriter is launched, these settings are loaded from this file.
This feature allows the user to re-define the position of the windows
for use on large displays and to set their PostScript printing
preferences.

Libraries
Libraries contain collections of customized images or groups of
images that have been saved for later use.  Essentially, they function
much like the Macintosh Scrapbook, but they can be freely created,
loaded and saved to disk.  They are discussed in detail in Chapter 3.
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Basic Operations
The following steps outline the procedure for producing your first
music score with NoteWriter:

• Open the program and select New from the File Menu.

• Specify a  page format for your document.

• Draw the desired music images using keyboard commands to load
the images and the mouse and/or keypad to place them on the
page.  You may draw material anywhere on the document in any
order.

• Edit the document by moving, adjusting, copying and pasting
images as necessary.

• Print the finished document in either Draft-quality mode or
High-quality mode at a specified reduction or enlargement.  Large
format documents may be printed in pieces (tiles) and taped
together to create large pages.

• Save the document in NoteWriter II format for further editing.  In
addition, the document (or fragments of the document) may be
saved in PostScript format or Paint format for insertion into word
processor, graphics or page layout programs.

• Quit the program
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Step 1:  Open the Program

Turn on the computer and locate the NoteWriter application (which
should be installed on your hard drive.)  If you have not yet installed a
copy of NoteWriter on your hard drive, you can use the copy of
NoteWriter on the Key Disk.

To start a new file open the NoteWriter application by double-clicking
the NoteWriter application icon or by selecting the NoteWriter icon
and choosing Open from the Desktop  File menu.  To open an
existing file, you may perform either of the above operations on a
NoteWriter document icon.

! Documents or fragments of documents which have been saved as
PostScript files or Paint files should not be used to launch NoteWriter.
These files are stored in TEXT (text) and PNTG (paint) format and
cannot be loaded into NoteWriter.

When NoteWriter is loaded, several small windows appear at the top
of the screen.

2.2: Initial NoteWriter screen.

The top window (Command Window) contains the command line and
function tools.  Below is the  Image Palette and to the right is the
Scroll Window.

All three windows may be moved by dragging the handle in the top-left
or lower-right corner.  The windows can be positioned anywhere on
the screen and may be re-arranged to customize your working space.
These positions are saved with the Save Preferences menu item. If
these windows get covered up by other windows, you can bring them
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to the front by selecting the  appropriate item from the Windows
menu.

When a NoteWriter file has been opened, or a new file created, the
Score Window appears below the Image Palette. In addition, there is
a Keyboard Window which may be used to play in notes with the
mouse (see Chapter 8).

Unlike most Macintosh programs, NoteWriter allows windows to be
active (and editable) even when they are not the front window.  This
feature allows windows (e.g. the Scroll Window and Keyboard
Window) to be overlaid on the Score Window.  To bring the score
window to the front (which is necessary in order to re-size it or move
it), click the title bar of the window.
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Step 2:  Set up a Page

To begin working on a new document, select New from the File menu.
The following dialog box appears:

Fig. 2.3:  Page Set-up Dialog

This dialog box allows all aspects of the basic NoteWriter page to be
specified.  Each page of a  NoteWriter document can be set to have a
physical size of from 3.5" to 32" in height and from 3.5" to 24" in width
(in increments of .5").  If you prefer to work in centimeters rather than
inches, click on the centimeter radio button.

Setting Page Size
Before beginning, you should know (or set) the paper size and page
orientation you intend to use when printing.  By default, you will be
printing on letter size paper in portrait orientation (11" tall, 8-1/2"
wide).  If you intend to print in landscape orientation or to use another
paper size, use the Page Set-up... menu item to indicate this before
setting up your new page.

The initial page size can be set either by typing the number in the
Page Height and Page Width text boxes or by dragging the page
outline by the handle in the bottom-right corner. (Each square in the
grid is equivalent to 1 square inch in the document.)  If you type
values into the Page Height and Page Width boxes, you can see the
resulting document size by clicking the Show Score Size button.

� In the Page set-up dialog box, the grid allows a maximum page size of
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24" X 32".  If you require a larger page, you can enter a number (up to
48) in the Page Height and Page Width text boxes and click Show Score
Size.

You can also select the number of staves you want on a page and
NoteWriter will automatically calculate the page size for you.

� Pages set-up this way will normally be printed at some degree of
reduction so that they will fit properly on the printed paper.  Since some
dot matrix printers do not allow variable reduction sizes, this method is
recommended only for use with laser printers or printers with a wide
range of printing reductions.

You should now set the number of pages you want for your score.
(You can, of course, always add or delete pages at any time while
working on a score.)

Setting up Multiple Pages
When a score is set up, you can specify the number of pages (up to
one hundred) in the document.

! The number of pages in NoteWriter documents are limited by the
amount of free memory in your computer.  In order to avoid excessively
large files and reduced efficiency in operating the program, it is
recommended that large scores be divided into several smaller files of
10 pages each.

To scroll through pages, use the left and right arrows in the
bottom-left corner of the score window.  The current page is displayed
in the page icon.  The arrows will be black if there are additional
pages before or after the current page.  To jump to a different page
use the Go To Page.. menu item from the Document menu and type
the desired page number.  To add a page to the end of your
document, use the Add Page menu item,  The new page will be added
with the original page set format (page size, staves, clefs, braces
etc.).

� When reading old NoteWriter files (version 1.0 - 1.3), it is possible to
add new pages, but not all page format information will be recreated on
the new pages.  The additional material can be copied from the original
page.
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To insert a page in the middle of a score use the Insert Page menu
item.  The page will appear in front of the current page.  To delete a
page, use the Delete Page menu item.  A dialog box appears to
ensure that you want to remove the page.

Setting Staff Format
The Space Between Staves item determines the distance (in staff
spaces) between the bottom of one staff and the top of the next.  The
number of staves in each system is also set with this dialog box.  The
four staff margin boxes determine (in increments of .5") the distance
that staves will be inset from the edges of the page.

For standard  staff configurations, a series of dialog boxes follow
which allow the clefs in each system and the key signature to be set.
If a two-staff system is specified, then you will also be asked to
choose between straight and piano braces;  if single staves are
specified, you will be asked whether you want a barline at the left edge
of the staves  and if a three-staff system is specified, you can choose
between  vocal-piano or instrumental layout. Click the OK button when
you are ready to continue.  If you want to create your own staff format
or if you want to begin with a completely blank page, you should select
the Other  button. When Other  is selected, the following dialog box
appears:

Fig. 2.4:   Custom Page Set-up Dialog

Adding Staves
Clicking inside the miniature page adds a staff to the document.  In

Chapter 2: Operating The Program    25

addition, the placement of staves can be controlled with the Auto
Spacing setting.  Rather than freely clicking the staves on the
miniature page, you can set the distance between staves (number of
ledger lines) in the Auto Spacing box and click the Add Staff button.
The next staff will be placed the specified distance below the previous
staff.

� To use the Auto Space feature, at least one staff must be entered by
clicking on the miniature page.

Removing Staves
A staff may be removed with the Undo Staff button, and you may clear
all staves and braces by clicking the Restart button.

Adding Clefs
Clefs can be be specified for each staff entered - the clef button
should be selected after the staff has been added to the miniature
page. (Clefs are indicated on the miniature page by small rectangles
at the beginning of the staff.)

Grouping Staves
Staves may be grouped (with a Straight Brace, a Curly Brace or with
No Brace - a single barline) by clicking the appropriate button.
Braces are be drawn from the first non-braced staff to the last entered
staff; you indicate braces as you are entering the staves.

Selecting the Done button causes the score to be drawn.

� Barlines joining the left edges of the staves may be added directly on
the score with the Draw-Line tool.  Single (or multiple) horizontal lines
for percussion parts may also be added with this tool.

� If your page does not turn out exactly the way you want it, you may
alter the staff positions by dragging them (refer to the editing
procedures in Chapter 4).  Also, you can change the size of the entire
score or an individual page by selecting Change Page Size from the
Document menu.

After the Custom Page Set-up dialog box has been closed, the Key
Signature dialog box appears.  To choose Key Signatures, click on
the appropriate button and the select Done.  You must have a Clef set
for a key signature to appear.  Staves without a Clef will not have a
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key signature assigned.  However, once the score has been created,
key signatures can be added manually.

� Key Signatures for treble and bass clefs are transposed to alto and
tenor clefs.  This means that some key signatures (especially with
tenor clefs) require that some accidentals be manually moved to the
correct octave.
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Step 3:  Use the Commands and Tools

The Command Window

Fig. 2.5: Command Window

The Command Line shows the current Notewriter command.  The text
which appears here indicates what image will be drawn when the
mouse button is clicked.  This command remains in effect until it is
replaced by a new command. The Image Palette, the Command
Window or the Macintosh keyboard can be used to enter the
Notewriter command.  Since commands are generally short
mnemonic codes for the music images, 1 - 4 characters (a maximum
of 8) are sufficient.

A display of Notewriter commands along with their associated images
is available with the Command List menu item in the Windows menu.
Clicking on one of the commands in the Command List dialog
automatically places it on the Command Line.

The palette of tools located to the right of the Command Line indicates
the current function mode of Notewriter.  Each of the tools has a
specific drawing or editing activity associated with it.  The active tool
(i.e. the current Notewriter function) appears highlighted on the Palette
- to change functions, simply click the appropriate box.

The  Notewriter tools with their associated cursors (from left to right)
are:
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Tool    Palette Icon  Cursor

Select-Region

Select-Rect

Eraser

Text

Insertion

Draw-Line

Draw-Oval

Horizontal Guide

Vertical Guide

Draw-Rect

Fig. 2-6:  Notewriter Tools and Cursors

Insertion tool
The Insertion tool (target cursor) is used for adding music images.
When the cursor is clicked in the document, the center of the target
becomes the current drawing position  the image will be placed at this
coordinate. This tool is automatically activated when a character is
typed on the computer keyboard (except when you are in Text mode)
or when an item in the Image Palette is selected.  The program begins
in Insertion mode.

Select-Rect tool
This tool (arrow cursor) is used to select Notewriter images for
editing.  As the cursor is dragged, a highlighted rectangle appears.
All Notewriter Control Points within the rectangle are considered to be
selected.  The document will scroll if you drag the rectangle past the
edge of the window.Note: The Return key can be used to switch
between Select-Rect and Insertion modes.

Select-Region tool
This tool (reverse-arrow cursor) is used to select a variable-shaped
region for editing.  Hold the mouse button down and draw around
images with the pencil.  The region becomes highlighted when the
mouse button is released.  As in the case of Select-Rect, all Control
Points within the region are considered to be selected.  This tool
allows precise editing of images in close proximity to one another.
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� When using either the Select-Rect or Select-Region tools, multiple areas
can be selected by holding down the Shift Key and selecting another
area.

Text tool
The Text tool (I-Beam cursor) allows standard Macintosh text boxes
to be created.  The font, size, style and justification are set by the
Text Format menu item in the Control menu.  When the Text tool is
selected, an I-Beam cursor will flash at the current text insertion point.
You may create a new  text box by clicking anywhere on the screen,
or click within an existing box to edit that text.   The initial size of Text
boxes can be controlled by the user.  If the mouse button is held
down during placement of the Text box, the user can move the mouse
to the right and create a text box of any length.  (The document will
scroll if necessary).  The height of the text box is set to the current
line height.  Text will wrap around automatically as the text reaches
the right edge of the text box and additional lines are added to and
removed from the text box as needed.  The size of text boxes is
adjusted after a new text format is set.  In addition, the overall size of
the text box can be adjusted by selecting the bottom-right corner of
the text box and dragging it. The position of the entire box may be
moved by selecting the top-left corner and dragging it.

� All text contained in the text boxes, whether or not it is visible on the
screen, will appear when the document is printed.  This allows you to
hide large text fragments (by reducing the size of the text box) if
desired.

Eraser tool
The Eraser tool removes images whose first Control Point (i.e. first
mouse click) is under the cursor while the mouse button is
depressed.  If you are not sure where the first control point is located,
you may display the control points temporarily with the Show Control
Points menu item.  (First Control Points are displayed in white, others
in light gray).

Graphics tools
The Graphics tools (cross cursor) is used to draw standard graphic
images (rectangles, ovals, and lines) on the screen.  Selecting the
Draw-Rect, Draw-Oval or Draw-Line boxes causes the corresponding
image to be drawn while the mouse button is held down and the
cursor moved. Holding the shift key down while drawing constrains

30   Chapter 2: Operating The Program 



the images to squares, circles and horizontal or vertical lines.  The
current line thickness is controlled by the Set Line Width menu item.
Ovals and rectangles can be drawn as framed (with different line
thicknesses), filled in black or as erasures.These graphics tools are
intended to allow you to create simple images from within Notewriter.
To create more complex images you can use a graphics program
such as SuperPaint , import the graphic and store it in the Symbol
Library (see Chapter 3).

� Although dotted lines may appear somewhat distorted on screen, they
will print correctly on the laser printer.

Vertical and Horizontal guide tools
These guide tools are used for placing vertical and horizontal
reference guides on the document.   When this tool is active, a dotted
line is drawn the entire length or height of the document.  Clicking on
the line a second time removes it.  Clicking on the small rectangle in
the top-right corner of the Guide box clears all the corresponding
guides from the page.  Vertical guides are very useful for aligning
beats, measures and other images down the page.Horizontal guides
can be used to line up text boxes or other images across the page.
Up to 40 vertical and horizontal guides may be active on each page of
the document.  All guides are saved with your file.

Image Palette

Current Image Current Modifiers

Fig. 2.7: Image Palette

The Notewriter  Image Palette contains some of the most commonly
used music images.  When one of the boxes in the Palette is
selected, the corresponding command is entered into the command
line and the box is highlighted.

Additional characters may also be added to the command with the
keyboard.  (E.g. Selecting the angled beam box will cause "a" to be
entered as the Current Command - if you require two beams, type "2"
on the keyboard and the number will be added to the command.)
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The accidental and dot items are used to extend the Current
Command with "." "sh" "n" and "fl", or to remove the extensions if they
exist.  (E.g. If you click the quarter note image followed by the sharp
image, followed by the dot image, the Current Command will be "qsh."
-- used to draw a dotted quarter note will a sharp in front of it.  Clicking
the sharp image again will cause the Command to be altered to "q.".)

The Image Palette contains only a small subset of available images --
a complete list of Notewriter images is available with the  Command
List menu item.  The Image Palette, the Keyboard and QuickScrawl
routines (discussed in Chapter 7) may all be used interchangeably to
draw images on the score.

Scroll Window

nudge 

Up-Down 
Scroll Arrows 

Visible Area 

Miniature Page 

Left-Right 
Scroll Arrows 

 

Fig. 2.8: Scroll Window

The Scroll Window was designed as an enhancement to the standard
Macintosh scroll bars.  Placing all scrolling functions in one area and
making this window moveable reduces the amount of mouse activity
during editing.  Clicking in the  Scroll Arrow boxes causes the
document to move by increments left, right, up or down.  Clicking the
stem of the arrow will nudge the document a short distance in the
desired direction. You can also, of course, use the standard Scroll
Bars to move your document.

The  Miniature Page shows the position of staves and braces in the
document and the visible portion of the document (in black).  The
visible portion of the document can to be moved by dragging the black
rectangle to a new location.  The Miniature Page and the visible
rectangle reflect the current page size and window size.

� The Notewriter Score Window can be re-sized by selecting the
bottom-right corner of the document and dragging it.
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Step 4:  Draw The Music Images

To draw images on the score, the Insertion tool must be active.  As
mentioned above, typing at the keyboard, clicking in the Image
Palette, or clicking on the item in the Command Window causes the
appropriate characters to appear on the Command Line.  This text
constitutes the  Current Command and is used to indicate which
image you wish to place on the screen.  The mouse is moved to the
desired location, and a click (or two or three) of the mouse button will
draw the image on the screen.  Chapter 3 deals systematically with all
Notewriter images and the methods for positioning them.  For now, it
is sufficient to say that the image specified by the Current Command
is drawn when the required number of mouse clicks have been
generated.

Generally speaking, images that are fixed to one location (e.g.
dynamic markings and rests) require only one mouse click, whereas
images which have variable height or width (e.g. notes, beams,
staves) require two mouse clicks, and ties and slurs (which have a
beginning, an end and a central point) require 3 mouse clicks.

To use Notewriter effectively, you must be familiar with the commands
for the commonly used images (many of which are included in the
Image Palette) and the number of mouse clicks required to draw
those images.  You may wish to move ahead to Chapter 3 and
experiment with some of the Notewriter images before continuing.

� You can continue to place copies of the same image while it remains as
the Current Command.  Also, selecting Undo from the Edit menu will
remove the previous change to the screen, but will not alter the Current
Command.
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Step 5:  Edit the Score

One of the most powerful features of Notewriter is that images may be
placed anywhere on the screen in any order, and that all images (or
groups of images) may be adjusted or modified at any time.  Also, all
Notewriter images (including staves, slurs, text and graphics) are
subject to the same editing procedures.

The  Select-Rect and  Select-Region tools are used for specifying the
portions of the score to be edited.  The Select-Rect tool selects a
rectangular area, while the Select-Region tool is used to draw freely
around groups of images.  In both cases, the selected area appears
highlighted.

In addition to the standard Macintosh editing procedures (Cut, Copy
and Paste), Notewriter includes Move,  Adjust, Stretch-Compress
and Delete routines.  In accordance with Macintosh conventions,
editing is always done on selected images -- you must first indicate
(with the Select-Rect or Select-Region tool) what material is to be
operated upon, then choose the appropriate menu item.  All editing
routines are discussed in detail in Chapter 4.
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Step 6:  Save the Document
W

you are working on your score your should save it to disk as often as
possible.  Using Save (from the File menu) will save your score in
Notewriter format.  When using Save As... you are asked which
format you wish to save your document as - NoteWriter format (with a
new name), PostScript format or MacPaint format.  Choosing the
PostScript format will allow you the options of saving your document
or the current page of the score as a PostScript document or as an
Encapsulated PostScript (EPS) file.  PostScript documents are
designed for downloading to other PostScript printers or for exporting
your score to a non-Macintosh computer.  EPS file are designed for
exporting pages of score into page layout programs.

When a document is saved, the page set-up features (i.e. the paper
size, reduction percentage, etc.) and the vertical and horizontal guide
positions for each page are saved with the document.
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Step 7:  Print the Document

Notewriter documents may be printed at any time provided that the
Chooser desk accessory is set for the printer you are using, and that
the printer is properly connected.  If you are printing to a PostScript
printer (i.e. in High-Quality mode), the  Sonata font should be located
in the System Folder on your start-up disk.  To print to a PostScript
printer select the Laser Print menu item from the File menu.  To print
to a non-PostScript printer select the Draft Print menu item from the
File menu.  It is a good idea to save your document prior to printing.

Notewriter uses the standard Macintosh dialog boxes under Page
Setup in the File Menu for printing.  In the most recent version of
these dialogs, you may set the paper size, orientation, reduction size,
the number of copies and other options.  A particularly useful setting
on the LaserWriter dialog box is  Larger Print Area.  This option
decreases the size of the margins on the page and gives you a full 8
inch width on the printer.

A gray rectangle on the screen indicates the current print area.
Changes to Page Setup affect the size and shape of this rectangle.
All material within the rectangle will be printed at the current Page
Setup specifications.  The position of the grey rectangle may be
adjusted in the Overview window (select Show Overview from the
Windows menu).  In the Overview, the current printing area appears
highlighted.  You may drag this highlighted area to a new location.

Large documents may be printed in pieces (called  tiles).  Normally,
this requires that a portion of the document be printed (at any
reduction size) and the origin (i.e. the position of the top-left corner of
the work area) be shifted (as described above) and another portion of
the document printed.  The number of tiles depends upon the size of
the document, and the reduction and enlargement percentage.  The
table in Chapter 5 may be helpful in organizing tiling for large
documents.

� If you print a page on a laser printer and get a score with letters instead
of music symbols, the Sonata font is not resident in the printer.  You
should save the file, download the Sonata font to the printer, and try to
print the original document again.
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Step 8: Quit the Program

When you have finished working with NoteWriter, select  Quit from
the File menu.  You will be prompted to save the document if you
have not already done so, and you will return to the Macintosh
Desktop .  If you want to save the document in  Encapsulated
PostScript format (EPS) or in Paint format, you should select the Save
As... item from the File menu prior to quitting.  Remember to save the
document in  NoteWriter format as well or you will not be able to open
the document again from NoteWriter .
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Chapter 3: Creating the Score
This chapter discusses the standard score entry procedure for
NoteWriter.  Although more efficient entry can be achieved using the
on-screen Keyboard and QuickScrawl routines (refer to Chapter 7 for
details), it is recommended that users begin by becoming familiar with
the standard entry method before working with the more advanced
input methods.

Standard Entry Method
In order to add a music image to the score, you must be in Insertion
mode - click the target icon in the Command Window if it is not
already highlighted.  The procedure for drawing is to first indicate the
image to be added,  then move the cursor and click the mouse at the
appropriate location or locations on the screen.  There are three
basic categories of NoteWriter images: those that require only one
cursor position for placement, those that require two, and a few that
need three or more.  The images which require more than one mouse
click do so because more than one screen position must be defined
before the image can be correctly drawn (beams are an example of a
double-click image -- you must specify the left and right boundaries of
a beam).

Setting the Command
All typing on the keyboard (except when you are in Text mode) affects
the  Current Command.  The Backspace (or Delete) key may be used
to erase letters, or you can use the mouse to insert or delete text as
you do in other Macintosh applications.  As much as possible,
commands were designed either as a mnemonic of the musical term
(i.e. "q" for quarter-note,) or they use a character that resembles the
image (i.e. "<" for crescendo or decrescendo).  Most NoteWriter
commands are one to three characters in length, and fit easily on the
Command Line.

With the exception of text, Commands should be entered as lower
case letters without spaces unless otherwise specified.  (E.g. "qsh" is
a correct Command "q sh" and "QSH" will not be understood by
NoteWriter.)  If you discover that a Command is incorrect while you
are positioning the image or if the image fails to appear on the screen,
the Backspace key will clear the Command and you can re-enter the
correct Command.  Also, once an image has been drawn, additional

Chapter 3: Creating The Score    39

typing will replace the previous Command.

Current Image Current Modifiers

Fig. 3.1:  Image Palette

Clicking in one of the boxes on the Image Palette is equivalent to
typing the corresponding Command.  Except for the  modifiers
(add-dot, add-sharp, add-natural and add-flat boxes), the new
Command replaces the previous one.  The four modifier boxes serve
as extensions to other Commands.  They cause the appropriate text
to be added to the existing command if the extension is appropriate.
Re-selecting one of these boxes will remove the extension. When the
Image Palette is used to enter commands, the current selection and
the current modifiers are highlighted.

The Command List (in the Windows Menu) contains other available
NoteWriter images in boxes.  Clicking on a box automatically loads
the image as the Current Command and closes the dialog box. (See
Appendix 4 - Command List).

Another method of entering symbols is to paste them into your score
from one of the Symbol Libraries.  (See the end of this chapter for
details on how to do this.)

The Insertion Cursor
The NoteWriter cursor has been designed as a circle with
cross-hairs.  The hot-spot or active point is the pixel (or picture
element) at the centre of the circle. This is the point from which and to
which most images are drawn.  Notice that the diameter of the circle
is the same as the distance between staff lines.  When the cursor is
superimposed on an existing image, overlapping pixels become white.
This allows you to see clearly whether the cursor is properly aligned
in a staff space or on a line.  (N.B. When you are correctly centred in
a stave space, the top and bottom edges of the cursor will disappear.)
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In a Staff Space

On a Staff Line

Fig. 3.2: Correct cursor position

As with any Macintosh program, a clean mouse and a smooth
working surface make the task of positioning images much easier.

Placing Images
In NoteWriter, the number of cursor positions required to draw an
image and the accuracy with which they must be placed has been
kept to a minimum.  The program will work much more efficiently once
you get a sense of what information NoteWriter requires in order to
draw accurately and what it can assume or infer from what you give it.
In most cases, the first cursor position is the most crucial.  The
second and third positions (when required) are usually drawn relative
to the first. For example, when drawing notes, it is important that the
note head (i.e. the first mouse-click) be placed with some accuracy,
but the second click (for the stem length) indicates only vertical
position of the image.  Also, since most images are adjusted to the
grid, a certain degree of inaccuracy is tolerated by the system.

The Grid
NoteWriter has an automatic adjustment feature which aligns most
images to an invisible grid. When the grid is engaged, images will be
vertically adjusted to the closest staff line or space and horizontally to
the closest grid point (4 pixels). This compensates for inaccuracies in
manual placement and aids in the vertical alignment of images.  If
desired, this feature may be turned off by selecting  Grid from the
Control menu.

Disengaging the grid may be necessary for precise placement or
adjustment of some images.  However, it is strongly recommended
that the grid be kept on except when fine adjustments are needed.  If
you enter images with the grid off, you may find that they are not
properly aligned or joined when the document is printed

The Vertical Alignment Bar
The Vertical Alignment Bar (V. A. Bar) consists of a vertical dotted
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line with a box containing  a staff and ledger lines affixed to it

Fig. 3.3: Vertical Alignment Bar

When the V.A. Bar is engaged, all notes and rests are aligned on the
vertical line -- other images are still drawn at the cursor position.  The
V.A. Bar may be moved across the page using the  Space and Tab
keys (reverse direction with Shift-Space and Shift-Tab) and small
increments with the ~ key.  The increments of this move are
determined by the Alignment dialog box (which is called by selecting
the  Set Alignment item in the Control menu).

The V.A. Bar sits on the staff, and may be used to enter pitches
above and below the staff more accurately.  The box may be shifted
to other staves by clicking the small arrows in the top-right and
bottom-right corners of the box.  Moving the box up and down in this
manner causes the document to scroll so that the next staff is clearly
in view - the current staff number is displayed in the upper left corner
of the V.A. Bar.  The V.A. Bar is turned on and off by the Alignment
menu item in the Control menu.

In addition, the Vertical Alignment Bar may be used in conjunction
with the on-screen  Keyboard.  The Vertical Alignment Bar is turned
on and off by the  Alignment On / Off menu item in the Control menu.
The Vertical Alignment bar can be set to increment automatically
when notes are entered by setting the Auto-Increment menu item in
the Control menu. (See Chapter 6)

Defaults
As an additional alignment aid, many images, such as rests and
barlines, are automatically adjusted to their normal drawing position
on the closest staff.  If unusual positioning is desired then the
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Defaults may be disengaged by selecting the Defaults item from the
Control  menu (and thereby removing the checkmark from the menu
item.)

Defaults On    Defaults Off

Fig. 3.4: NoteWriter Defaults

Figure 3.4 shows the cursor positions and the resulting drawing
positions of an eighth-note rest with Defaults on and off.  As you can
see, Defaults cause the rest to be placed in normal position in the
closest staff.

Another important Default is the automatic association of notes with
the closest staff.  Normally, NoteWriter will decide which staff a note
"belongs to" and draw ledger lines to this staff if needed.  If you do not
want a note to be associated with any staff, then disable Defaults
before adding the note.  A complete list of NoteWriter Defaults is
given in Chapter 6.

� As in the case of the Grid, Defaults should remain engaged except when
it is absolutely necessary to turn them off.

Control Points
Every NoteWriter image has one or more Control Points associated
with it.  These points are the essential drawing coordinates of the
image, and are vital to all the editing routines.  In most cases, the
Control Points are the locations at which the mouse button is clicked
when the image is drawn, or where the image initially appears on the
screen.  Normally, single-click images have one Control Point,
double-click images have two, and  triple-click images have three.
Unlike some other graphics applications, the Control Points (or
handles) are not normally visible on the screen. (You may view the
Control Points temporarily by selecting the  Control Points menu item.

Primary control points are displayed as white boxes, while other
points are grey.)  The reason for not normally showing control points
is that editing can easily be done intuitively with NoteWriter.  It is not
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necessary to consciously grab handles to adjust images.  As the
drawing methods for the various symbols are discussed, any unusual
locations of Control Points will be mentioned.

Figure 3.5 Control Points
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Commands for Single Click Images
Single click images are those which require only one cursor position
for placement.

As a general rule, they are drawn directly at the cursor position and
the Control Point of the image is placed at this location.  However,
there are some images (e.g. barlines and rests) that will normally be
adjusted to the closest staff and some images (e.g. barlines, full
staves, rehearsal numbers, and key signatures) have two or more
Control Points despite the fact that only one was required to draw the
image.  The additional control points are provided so that the image
can be adjusted more easily.

Rests
The commands for rests all have "r" as the first letter.  The second
letter distinguishes the kind of rest (i.e. "rq" = a quarter rest).  In
addition, a dot "." may be added to the command (either by typing or
clicking on the Image Palette) to indicate that the appropriate rest is to
be drawn with a dot following it.

Rests will default to their normal position on the staff.  To position
rests elsewhere you must first deactivate the NoteWriter Defaults (by
removing the checkmark from the Defaults item in the Control menu),
then place the cursor at the desired location and click the mouse
button.

Rests are aligned to the Vertical Alignment  Bar when it is engaged.
Thus, when Defaults are on and the Alignment Bar is active, clicking
anywhere on the screen will cause the rest to appear vertically at the
centre of the closest staff and horizontally at the Alignment Bar.  The
Control Point for a rest is located at the centre of the image.
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rw     rh     rq    re     rs     rt      rsf

rw.    rh.     rq.   re.    rs.    rt.    rsf.

Fig. 3.6: Rests

Clefs
Clefs are drawn to the right of the cursor.  When NoteWriter Defaults
are engaged, the normal sized clefs will be drawn in normal position
on the staff.  To place these clefs elsewhere (as is necessary for
soprano clefs for example) you should deactivate the Defaults and
click the cursor on the appropriate line.  The normal drawing position
is the centre staff line.  Small clefs (which have a "!" prefix) are not
automatically adjusted to staves.  The Control Point  is the located at
the left-centre (normally at the centre staff line) of the image.

tc           ac          tnc        bc

!tc        !ac         !tnc       !bc

Fig. 3.7: Clefs

Dynamic Indications
The first letter of the dynamic mark is centred on the cursor.  The
subsequent letters, if any, are drawn to the right of the cursor. Neither
the Grid, Defaults, nor the Alignment Bar affect the position of
dynamic indications.  The Control Point is located at the cursor
position.
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 ffff            fff           ff            f         mf        mp

p    pp     ppp       pppp   sf       sfz        fp

Fig. 3.8: Dynamic Indications

Accidentals
Accidentals may either be added as independent images, or they may
be included as part of a note image.  There are certain editing
advantages to ensuring that accidentals are associated with notes
rather than drawing them as independent images.  However, in some
instances, it may be necessary (or desirable) to add accidentals as
separate images.

To draw an accidental, click the mouse button where you want the
image to appear.  All accidentals are drawn directly over the cursor
at the closest staff line or space.  In addition to the regular
accidentals, NoteWriter includes two sizes of smaller accidentals for
grace notes, and 1/4  sharps and flats for use in contemporary music
scores.

The procedure for having accidentals included as a component of a
note is to create a  compound Command (i.e. a Command which
includes both the note command and the accidental command -
"qsh"), or to select an existing note (with the Select-Rect or
Select-Region tools) and choose the appropriate item in the Modify
menu to add an accidental to the selected notes.  Also, accidentals
may be added with the on-screen Keyboard and with Numeric
Keyboard Input.
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dsh   sh     n     fl      dfl    sh1   sh3   fl1

!dsh  !sh    !n    !fl    !dfl

gds  gsh   gn    gfl    gdfl

Fig. 3.9: Accidentals

Key Signatures
Key signatures at the beginning of each staff are normally generated
during the initial page set-up routines.
If you want to add a key signature elsewhere in the document, or if
you specified your own document layout (without key signatures) you
may use the key signature commands.  The command "ks" draws
sharp key signatures and "kf" draws flat key signatures.  The number
which follows these characters determines the number of accidentals
to be drawn.  Thus, "ks2" draws the key signature of D major / B
minor.  The cursor should be placed on the pitch B (middle line of the
treble clef, second line of the bass clef, etc.) at the horizontal position
of the first accidental.  Some key signatures (in alto and tenor clefs)
may require that some accidentals to be shifted up or down an octave
-- this is easily accomplished with the Move procedure.

ks2            kf3              ks6 
Fig. 3.10:  Key Signatures

Text
The majority of text in NoteWriter should be entered by creating
standard Macintosh text boxes with the Text tool.  The method for
doing this is discussed later in this chapter. There is, however, a
second method that can be very useful for adding short fragments of
text to the document. The size of the text is taken from the current
setting in the Text Format dialog box (in the Control menu.)  The font
used to draw text is Times-Roman, and the maximum length of the
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text segment is 8 characters.To add text using this method, type a
single quote - ’ - followed by the text you want displayed, and click the
mouse once at the location you wish the text to begin.  The bottom-left
corner of the first character will be placed at the cursor position.  This
procedure is very useful for adding fingerings, small measure
numbers, analytical letters, single syllables, etc.  For longer
passages, and to utilize other styles and fonts, use the Text tool.  The
size of single-click text fragments can later be changed by using the
Modify Text items in the Ext. menu.

Time Signatures
The command for time signatures consists of the numerator and
denominator separated by a slash - / (i.e. "4/4").  Any time signature
with one or two digits in the numerator and denominator is possible in
NoteWriter.  The cursor should be placed on the centre line of the
staff.  Common and cut time may be drawn with the commands "c"
and "c/".

The time signature images may also be used as numbers (up to 4
digits).  This is useful for constructing complex time signatures (e.g. 6
+ 3 over 8).  These number can be entered separately and the plus
sign added with the ’-type text routines described above.  It is also
possible to create a time signature with a number over a musical note
if desired.  The first digit is centred on the cursor.

Large time signatures (for chamber and orchestral scores) can be
created with a large point size in a regular text box.  (Try setting the
Sonata font to 72 point and typing the numbers.)

4/4       12/32       143           c          c/ 
Fig. 3.11: Time signatures

Ledger Lines
Although ledger lines are available as separate images, it is not
normally necessary to use this command since ledgers are added
automatically when notes are entered.  Nevertheless, they are
available should you require them for any reason.

The command for ledger lines consists of "l" followed by the direction
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("u" for up and "d" for down), followed by the number of lines to be
drawn.  Therefore, the command "lu4" is used to draw four ledger
lines above the staff, the command "ld5" is used to draw five ledger
lines below the staff).  The cursor should be positioned on the top
staff line for upper ledger lines, and on the bottom staff line for lower.
As with many NoteWriter commands, there is a default.  In this case,
the default direction is up, and the default number is 1.  If either the
direction or the number is omitted, the default is used.

lu3      ld2      l5        ld 
Fig. 3.12: Ledger Lines

� As long as Defaults are engaged, ledger lines will automatically be
added to all notes.  You may change the staff to which notes are
associated with the  Next Staff and  Previous Staff menu items.

Barlines
Barlines "bl" and double barlines "dbl" are drawn by specifying the
horizontal location in (or above) the appropriate system.  NoteWriter
will take care of drawing the barline (or barlines) between the top line
of the top staff and the bottom line of the bottom staff in any
established staff system.

The commands "|." and ".|" are used to draw begin-repeat and
end-repeat barlines.  The repeat dots appear on every staff in the
system.  Although barlines are drawn with only one click, they have
two control points (at the top and bottom of the line), so that they may
be edited more easily.

If you deactivate Defaults, all barlines will be drawn down from the
cursor position the standard staff height.

If you wish to group staves differently from the way they are formatted
on the page, you may use the Line tool or the command "|" to add
vertical lines anywhere in the document.
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bl        dbl        |.          .| 
Fig. 3.13: Barlines

Articulation Marks and Other Images
Most of the following images are centred on the cursor.  The
exceptions are grace notes which require the cursor to be centred on
the appropriate staff line or space (they are all drawn with flags up)
and string tremolo beams which are drawn in a downward direction
from the cursor.  All of these images have a single Control Point at
the cursor location.

 
      .      ...     _    _.    ._     >    >> 

      ^    ^^      ‘    ‘‘     ,      ped    * 

     gf      gfd    gft     gfs   gfds  gfts 

    ferm   fermu turn  mord   $   coda 

    /    //     ///    %      gtr     r23     RB 

ub    db     o    lv     g(      ;d 
Fig. 3.14: Other Single-Click Images

The two rehearsal symbols (in a rectangle and an circle) actually
consist of two separate images -- the number (or letter) as a ’-type
text item, and the graphic image (rectangle or circle).  Either or both of
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theses components may be adjusted or moved.  The guitar chord
image is drawn without any circles for fingers.  It is recommended that
the circles be added by drawing them with the circle tool. Set the line
width to a thick setting to place the solid circles and use the
"harmonic" symbol in the Command List for the open strings.  You can
also use the extensive set of chords provided in the Symbol Library -
see the end of this chapter for details.

The last image in Figure 3.14 (";" followed by a single character) is for
creating lute tablature and uses a lute font (which was designed by
Lyle Nordstrum).  If require this font, contact Opus 1 Music Inc. for
information on how to obtain it.

Global Commands
There are a number of single click images which can be drawn on
every staff of the page by adding the global prefix "&" to the
command.  Specifically, the images affected are barlines and time
signatures.

NoteWriter Image Command Global Command
Barline bl &b
Double barline dbl &dbl
Begin Repeat |. &|.
End Repeat .| &.|
Common Time c &c
Cut Time c/ &c/
Time Signature #/# &#/#
Key Signature ks#, kf# &ks#, &kf#

When any of these commands are altered to global commands  (i.e.
4/4 is replaced by &4/4), the image will appear at the horizontal
location of the cursor and at the normal location on every staff on the
page.  These commands are especially useful for adding barlines and
time signatures to large scores.  In the case of barlines, the lines are
drawn between the top and bottom staves of each staff groups that
were established when the document was set up. If you disengage
the Defaults, barlines will be drawn on all staves individually.

� Because globals are drawn as a series of separate images, they cannot
be removed by selecting Undo.  To remove the images select the
Remove Last Image menu item repeatedly until all copies of the image
are gone.
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Commands for Double Click Images
Double-click images are those which require two cursor positions in
order for the symbol to be drawn.   Notes and beams are examples of
double-click images.

In most cases, more accuracy is required in placing the first mouse
position than the second.  For example, a quarter-note "q" will always
have its stem drawn vertically up or down from the first position even
if the second position is not directly above or below the first.  Thus, it
is important to indicate the correct horizontal and vertical position for
the first click, but only necessary to specify the correct height for the
second.  The two Control Points  for double-click images are located
at the extremities of the image -- (e.g. note head and end of stem or
flag for notes, left and right edges for beams).

Fig. 3.15: Control Points for Double-Click images

As a general rule, you should enter horizontal images by placing the
the left position first.  Since many NoteWriter editing procedures
operate only on images whose first Control Point is selected,
following this protocol will simplify editing -- you can assume that the
left edge of a beam or horizontal line is the first Control Point.

Notes and Chords
All notes, except the whole note and double whole note (breve),
require two mouse clicks.  The first mouse click places the head of
the note, and the second draws the stem (or flag) to the height of the
second cursor position.

� A double-click with the command "q" or a single click with the command
"q1" draws a solid notehead without a stem.  You can use this image to
add additional notes to a existing stem when creating chords.

The standard stem and flag height is drawn when the second mouse
click is less than octave above or below the position of the notehead.
(The height of the stems and flags can be adjusted later if desired.)
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The commands "qq" and "hh" can be used to draw shorter stems (in
the direction indicated by the second click.)  Variable length stems
allow you to more accurately draw chords, notes in extreme registers
and notes with no stem.)

When beams are added to notes (either manually or with the Beam
Notes menu item), the stems will be adjusted to meet with the beam,
so it is not necessary to be overly concerned with the initial height of
the stem or flag.

 

      dw      w     h        q       e       s        t      sft 

     gw   gh        g        ge     gs       gt 

    sm      q1      G       +      dia    sdia 
Fig. 3.16: Notes

The command "sm" may be used to draw a stem without a notehead
on it.  It should not be used to extend existing stems - use the Adjust
editing procedure to alter the length of stems.

Grace notes appear in two sizes: "g" grace notes are approximately
1/2 the size of regular notes and "G" grace notes are 3/4 the size of
regular notes.

� Immediately after notes have been entered, they may be shifted up or
down or right and left with the cursor (arrow) keys on the keyboard.

Automatic Ledger Lines
When notes are entered, they are normally associated with the staff
closest to the note head, and ledger lines are drawn if the note is
above or below the staff.  The  Vertical Alignment Bar  can be used to
help position notes in extreme registers.  Occasionally, when notes
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are entered (or when pasting notes into the document) they may
become associated with the wrong staff -- i.e. ledger lines will be
drawn up to the previous staff rather than down to desired staff.  If
this occurs, select the incorrect notes (with the Select-Rect or
Select-Region tools) and choose the Previous Staff  or  Next Staff
items from the Modify menu.

If you do not want ledger lines added automatically, disable the
Defaults  temporarily.

� Occasionally unwanted ledger lines may appear.  To remove them, use
the  Remove Ledgers menu item from the Modify menu.

Compound Commands
The following suffixes may be added to any of the note commands to
have a dot or an accidental associated with the note.

Command addition               Image added
. Dot
sh Sharp
n Natural
fl Flat

These extensions may also be added to the command by clicking the
appropriate box in the Image Palette.

Alternatively, it is possible to enter notes without accidentals, and to
add the accidentals later by selecting the note and choosing one of
the menu items in the Modify menu (e.g.  Add Double Sharp  or Add
Dot) .  These menu items may also be used to alter accidentals at any
time during editing.  Accidentals which are associated with grace
notes will be drawn as grace note accidentals.

Quarter tone accidentals must be added as independent images.

� Dots and accidentals associated with notes are considered to be
modifiers.  To remove these images, select the note (using the
Select-Rect or Select-Region tools) and choose the  Remove Modifiers
item from the Modify menu.

Control Points for Notes
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Since notes are the most important images on most scores, it is
important to know where the Control Points are located for these
images.  The first Control Point is at the centre of the note head, and
the second is located directly above or below the note head at the
height of the stem.  Please notice that the second Control Point is not
located on the stem, but rather is positioned just to the left or right of
the stem depending on the stem direction.

Fig. 3.17: Control Points for Notes

Flags
As you can see from Figure 3.17, flags are automatically drawn when
you use the commands "e" ,"s" ,"ts", or "sft".  Independent flags have
also been included in NoteWriter, but will probably be used very
infrequently.  They are useful for rhythmic indications on tablatures or
in contemporary scores.  The Control points are located at the start of
the stem and at bottom or top edge of the flag.

   sflag        dflag         tflag          qflag 
Fig. 3.18: Flags

Drawing Simple Beams
Beams can be drawn by hand, by selecting notes and choosing the
Beam Notes menu item or they can be added automatically (by
choosing Auto Beam from the Control menu.)  See Chapter 4 for
details on Auto Beam.

There are two categories of drawn beams in NoteWriter: angled
beams (which use the "a" command) and horizontal beams (which
use the "b" command.)  Grace beams can be drawn with the "ga" or
"gb".

� The beam in the Image Palette is an a-type beam.
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To draw multiple beams, the number of beams to be drawn (up to 9) is
added to the Command. (E.g. "b3" will draw three beams -
thirty-second note beams.)  Click the mouse on the stems of the first
and last notes to be beamed, at the desired vertical positions.  The
specified number of beams will be drawn either from mouse position 1
to mouse position 2 in the case of a-type beams, or from mouse
position 1 horizontally to mouse position 2.  The stems of quarter
notes, grace notes, x-notes and diamond notes are clipped or
extended so that they touch the primary beam.

    b2              a3            gb3         ga 
Fig. 3.19:  Beams

� It is possible that notes may become joined to the wrong beam if they
happen to be in too close proximity to the beam when it is drawn.  If this
happens, the stem of the note can be adjusted back to the correct beam
(using the Adjust procedure).  Note, however, that if you alter the
position of the beam by adjusting, moving or pasting it, the note may
again become joined to the beam.

Normally, NoteWriter decides which direction to draw the beams by
looking at the location of the first Control Point.  If the cursor was
clicked below the middle line of the closest staff, then the program
assumes that the notes are above, and beams are drawn in upward
direction.  It the cursor was above the middle staff line, then the
beams are drawn in a downward direction from the Control Points.

� If a beam is drawn in the wrong direction, you may correct it by
selecting the beam and choosing the  Flip Beam Direction  item in the
Modify menu.

   Incorrect     Select and Flip      Correct 
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Fig. 3.20: Changing the Beam Direction

If you want control over the beam direction, or if there are no staves
on the page, you may disengaged the automatic beam direction
routine by selecting (and removing the checkmark from) the Defaults
menu item.  With the Defaults disabled, the commands "b", "a" "gb"
and "ga" cause beams to be drawn in a downward direction (i.e.
above the notes) and double letters -- "bb", "aa", "gbb" and "gaa"
cause beams to be drawn in an upward direction.

Drawing "Short" Beams
Short beams may be added to the left or right stems by adding "." (for
the right stem) or "," (for the left stem) in the command.   Short beams
may be added to any beam type.

b.                b,            a3.,          gb2.        ga, 
Fig. 3.21: Short Beams

Drawing Complex Beams
Rather than piecing together a series of beams, NoteWriter allows
complex rhythmic configurations to be drawn as a single image. This
procedure has a Command which begins with "b" or "a" and is
followed by a list of the numbers of beams which will appear from left
to right in the beam group.  To draw the beam, you must click the
mouse on the first stem (i.e. the left stem of the group), at every
horizontal location where the number of beams changes, and on the
last stem (i.e. the right stem of the group).  Normally, you will click on
intermediate stems which have a different number of beams on either
side.  A couple of examples will make this clearer: a rhythmic group of
an eighth and two sixteenths requires the command "b12" or "a12"
and is drawn with clicks on all three stems.  A rhythmic group of an
eighth, two sixteenths, two eighths and three thirty-second notes
requires the command "b1213" or "a1213" and mouse clicks on the
first, second, third, sixth and last stems (i.e. at all the places where a
change in the number of beams occurs.)
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Command: 
Click #: 

a12                     b1213 
1    2    3             1       2    3                   4      5 

Fig. 3.22: Entering Complex Beam Groups

Complex beams with short beams are drawn with additional mouse
clicks a short distance to the right or left of the stem.

Command: 
Click #: 

a12131                      
1       2 3              4 5   6 

Fig. 3.23: Entering a Complex Beam Group with Short Beams

Drawing Single Beams
Single beams may be added with the commands: "sb" (horizontal) and
"sa" (angled). These beams do not clip stems, so they may freely
used to extend existing beams, or to create  rhythmic accelerandi
and decelerandi.  The drawing positions of single beams are shown
below:

sa                       sb 
Fig. 3.24:  Beaming Notes with Single Beams

Set Stem Clip
This item in the Control menu allows you to set the way that stems are
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clipped when beams are added.  You can set beams to clip notes in
both directions (i.e. above and below the beam), in one direction only
(as determined by the position of the beam) or to not clip stems at all.

Brackets for Rhythmic Groupings
Brackets are specified as being upper or lower (i.e. above or below
the music) with the commands "[" or "]".  To include a number in the
centre of your bracket, add it to the command -- any two digit number
can appear in a bracket.   Alternatively, numbers  (e.g. 5:4) may be
added as text (using the ’... command or with normal text boxes).

[3                       ]5                 [                 ]12 
Fig. 3.25: Rhythmic Braces

Lines
Although lines are usually drawn with the Draw-Line tool, they may
also be drawn with the following commands:

Command Type of line
| vertical
|| broken vertical
- horizontal
-- broken horizontal
\ any angle

In addition to these basic commands, a number (up to 9) my be
added to the command to specify the thickness of the line.  For
example, the command "--3" would draw a broken horizontal line of
three pixels thickness.  Thick lines are drawn to the right and below
the cursor position. The Control Points are located at the beginning
and end of the line.

� Vertical lines may be used to create various thicknesses and dotted
barlines.

Line Erase
The commands "x", "y", and "xy" erase a line the thickness of the
cursor in the following directions:
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Command         Type of line
x horizontal
y vertical
xy any direction

These commands should not be used to erase images (use the
Eraser tool or Delete procedure to do this.)   Rather, they are used to
block out a portion of an existing image.  For example, if you want to
make a break in the middle of a beam or a slur (perhaps to avoid a
collision), you can use the "y" command and click above and below
the beam to make the erasure.  Any images which were drawn prior to
the erasure will be covered by the line, but additional images may be
placed on top of the erasure.  Conceptually, the erasures can be
thought of as strips of white tape which are placed on the page.  All
images (including staves) can be covered by erasures.

� The erasure routines are difficult to work with because you are
essentially dealing with invisible lines.  These lines may be adjusted,
moved and copied like any other NoteWriter image, and can sometimes
be altered inadvertently to cover another images.  They should,
therefore, be used with extreme care.

Original          y-Erase          Result 
Fig. 3.26: Line Erase Procedure

It is also possible to erase rectangular or oval regions by using the
Rectangle and Oval tools and setting the Erase Area radio button in
the Set Line Width dialog (in the Control menu).  With this setting,
rectangles and ovals will be drawn as erasures.

Staves
A staff may be placed anywhere on a NoteWriter document by typing
the command "st" and specifying the top-left position of the staff (first
click) and the length (second click).  Staff lines will always be drawn
horizontally and the new staff will appear in the Miniature Page  in the
Scroll Window.
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A smaller staff (height 75% of a regular staff) is available with the "!st"
command.  This staff can be used with the smaller clefs, grace notes
and grace notes beams in a limited way for ossia or ornamentation
examples.  NoteWriter, however, does not include a complete set of
reduced images and it is not recommended that you attempt to enter
extended passages of smaller images.  If you are adding images to a
smaller staff you must disable the Grid since the smaller staff spaces
will no longer be aligned to the Grid.  It is possible to add other
reduced images  (i.e. rests, dynamics, etc.) as Sonata text.  To do
this:

• Set the Text Format to Sonata plain 24 point (use the Text
Format item in the Control menu

• Create a text box on the document by selecting the Text tool and
clicking on the score.

• Type the keyboard equivalent to the desired image (use either
the  Key Caps  desk accessory or the keyboard map included
with the Sonata font package to find the correct character.)

• Make the text box as small as possible, and move the text box
(with the Grid disengaged) so that the image appears in the
correct position.

A staff drawn from left to right margins (i.e. a full staff) can be added
with the "fst" command;  this image requires only a single click at the
vertical location of the top staff line.  The Control Points for all staves
are located at the left and right edges of the top staff line.

st                                         !st 
Fig 3.27: Staves

A staff with wider spaces (designed for use with lute or guitar
tablature) can be added with the ":" command.  As in the case of "fst",
you need only specify the top line of the staff and it will be drawn from
left to right margins.

! Staves are assumed to go across the entire page - even if they are only
partial staves.  It is, therefore, possible to have notes associated with a
staff that is not visible at a particular horizontal location in the score.  If
this causes ledger lines to be incorrectly drawn, you can either remove
them with the Remove Ledgers menu item, or associate the notes with
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the correct staff using the Next Staff and Previous Staff menu items.

Staff Braces
Staff braces of various lengths may be drawn with the "(" command
for straight braces and "{" for curly braces.  The first cursor position
should be the top-right corner of the top staff, and the second cursor
position should be the bottom line of the bottom staff.  The first
Control Point  is located at the same position as the staff Control
Point, and the second Control Point is located at the base of the
brace.  Braces may be any length, may be placed anywhere on the
page and may include any number of staves.

(                   { 
Fig. 3.28: Straight and Curly Braces

Other Double-Click Images
Arpeggio  indications ("arp") are drawn by specifying the top and
bottom limits of the arpeggio.

Trills  ("tr") are drawn by specifying the start and end points of the trill.

Octava  indications are drawn with "oct".  The second cursor position
determines not only the length of the broken line, but also controls the
direction of the end bracket -- if you want the end bracket to turn up
then the second cursor position should be higher than the first.

The command "sl" draws a slash (at 45 degrees).  The first cursor
position is the starting point, the second determines the height and
direction of the slash.  The slash will be drawn at a 45 degree angle to
the height of the second cursor position.  This image is intended to be
used as a slash across the beams of grace note groups.

Of all the double-click images, the only one with an unusual input
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method is the "<" command which is used to draw crescendo and
decrescendo marks (or hairpins.) When using this command, you
must specify the point of the hairpin as the first cursor position, and
one of the outer edges as the second.  This will mean that crescendo
marks are drawn left to right and decrescendo are drawn right to left.
Remember, the second "leg" of the mark will be mirrored above or
below the centre point.  The length and height of the crescendo may
be edited later if needed.

Multiple measure rests for instrumental parts may be added with the
"=" command followed by the number to be centred in the image.
Specify the left and right edges of the image with the cursor.

arp            tr                      oct                    oct 

sl                 <                     <                   =123 
Fig. 3.29: Other Double-Click Images
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Commands for Triple Click Images
There are only three music images which require three cursor
positions:  slurs, ties and curved lines.  Slurs and ties "fatten" in the
middle when they are printed, while curves are uniform in thickness.
Curves are entered in exactly the same way as slurs are, but can be
drawn in various thicknesses (or as dotted lines).  To set the
characteristics of curved lines refer to the discussion of Graphics
later in this chapter.

Command Image
slur slur
tie tie
cur curved line

Slurs and Ties
The distinction between ties and slurs in that ties occur between two
notes of the same pitch, while slurs may include two or more different
pitches.  Ties are drawn to and from the same vertical axis, whereas
slurs may begin and end at different vertical locations.

The first cursor position determines the starting point of the image.  In
the case of the slur, the second mouse click specifies the position of
the maximum height (or depth), and the third determines the end point.
In the case of ties, since the height is calculated by NoteWriter and
they are drawn symmetrically, the second cursor position merely
indicates the direction of the tie (up or down), and the third specifies
the length of the tie.

� The  Add Tie item in the Modify menu can be used to draw ties between
two selected notes.  This is a more efficient and more accurate method
of adding ties.  Also, Tie direction may be flipped with the  Change Tie
Direction  item in the Modify menu.

Slurs and curves can be drawn between any starting and ending point
in a variety of ways depending on where you place the second cursor
position.  They are normally drawn on the screen as two arcs - from
cursor position one to two, and from two to three.  Because of this,
slurs which arc upward should have the second cursor position
higher than the first and third, and those which arc downward should
have the second position lower than the first and third.  If you want a
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slur with only a single arc from the first point to the third point, you
should place two of the clicks at one of the ends of the slur.  This
causes either the first or second of the arcs to be omitted.  Figure
3.30 should make this clear.
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Figure 3.30: Slurs with the Locations of Mouse Clicks
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Figure 3.31:  Ties with the Locations of Mouse Clicks

Control Points for slurs and ties are located at the ends and at the top
or bottom of the arc.  Normally, the middle point can been located
quite easily during editing because the arc becomes flat at this point.

Note: Because of the difference between the methods used to draw
slurs and ties on the screen (QuickDraw) and on the laser printer
(PostScript), you should exaggerate the arc of slurs and ties slightly
when entering them.  When printed on a laser printer the shape of the
arc will be slightly altered.  Figure 3.32 shows the same passage
printed on a dot matrix printer and on a PostScript laser printer.
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QuickDraw Slurs
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PostScript Slurs

Fig. 3.32:  QuickDraw  and  PostScript  Slurs.
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Text and Graphics

Text Boxes
Text is normally added in NoteWriter by placing a Macintosh text box
on the screen and typing text into the box.  Each text box contains text
of only one font, size and style although there may be as many
different text boxes in the document as memory will allow.

When the Text tool (letter A in the Command Window) is selected the
cursor changes to the standard I-Beam text cursor.  You may either
click in an existing text box to edit the material in that box, or you may
click anywhere on the screen to create a new text box.  New boxes
are created by clicking and dragging the mouse to create a box of any
size. The size of the box can then be altered by selecting the
bottom-right corner (Control Point 2) of the text box and dragging it.
The position of the entire box can be altered by selecting and
dragging the top-left corner of the box (Control Point 1).

Text can be imported from other programs by selecting and copying
the text in another program, creating a text box in NoteWriter, and
(with the cursor flashing in the Text box) selecting the Paste item from
the NoteWriter File menu.

! When the Text tool is selected, all typing at the keyboard is entered into
the active text box.  If you forget to switch back to Insertion mode
before typing the next command, the typed characters will be inserted
into the last text box rather than appearing as the Current Command.

To change any characteristics of the text,  select the Text Format
item in the Control menu.  The dialog box which appears allows
justification, font size (up to 99 point) and style to be specified.  Click
the OK button when you are done.
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Figure 3.33:  Text Format dialog box

� Since NoteWriter images are enlarged on the screen, and reduced to
75% when printed in High-quality mode, you should use larger text sizes
than normal when setting the text format.  16 point on the screen is
equivalent to 12 point on the printer.

When editing existing text boxes, you should treat them as any
standard Macintosh text box.  You may place the cursor anywhere in
the box, delete and add text, or copy and paste text between text
boxes using the  Cut, Copy and Paste items from the Edit menu. You
may perform these operations without affecting the contents of the
NoteWriter buffer.

� Changes made in the Text format dialog box affect the text box that is
currently active.  A text box is active if the text-insertion cursor (a
single vertical line) is blinking.

! Do not use Undo to reverse changes within text boxes.  Undo is
concerned only with NoteWriter Images and not with text within one of
the images.  Selecting Undo may cause the Text box to be removed.

The example below shows text boxes (in various fonts, sizes and
justifications) as they appear on the screen and as they appear when
printed:
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Figure 3.34 NoteWriter text boxes on the screen.

16 Point Times Plain
Left Justified

18 Point Helvetica Bold
Centre Justified

Courier Bold Italic Underline
10 point

Right Justified

Figure 3.35:  NoteWriter text boxes when printed.

Text in text boxes automatically wraps around. In addition, you can
press the Return key to move to the next line.

Text that is outside the visible area of the text box will still appear
when the document is printed.  This means that large text fragments
may be partially hidden if desired.  Since documents with a large
number of text boxes in various sizes may slow the speed of screen
updates,  a  Hide Text item (in the Control menu) is available.

Using the Sonata Font in Text Boxes
If you want to add any of the Sonata font symbols at any point size,
you may do this by setting the font to Sonata (with the Format dialog
box), creating a text box, and typing the key that corresponds to the
desired image.

This procedure is very useful for creating large time signatures, or for
adding articulation marks, small notes for use as metronome
indications, etc.

A keyboard map of the Sonata symbols is included with the font
package.  As a size reference, NoteWriter images are drawn at the
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equivalent of 32 point size.  The example below shows a half note
entered as Sonata text (at 18 point) and additional text (of the ’-type)
placed beside it.

  On Screen        On Printer 

� =166 

Fig. 3.36: Using the Sonata Font as Text

Graphics
The three Graphics tools:  Draw-Rect,  Draw-Oval and Draw-Line are
used to draw rectangles, ovals and lines on the score.  Unlike other
NoteWriter images, graphics are drawn by clicking the mouse once
and dragging the cursor until the image is the correct shape and size.
The thickness of the line (or a dotted line) may be specified with the
Set Line Width  menu item.  This menu sets the characteristics of
rectangles, ovals, lines and curves (entered with the Command "cur"
and drawn in the same manner as slurs).

Fig. 3.37 Set Line Width dialog

� When using the Thin Gliss and Thick Gliss line settings, the lines will
appear on screen as solid lines, but will appear as wavy lines when
printed on a PostScript laser printer.
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When the shift key is depressed, lines are constrained to straight
horizontal or vertical lines, rectangles to squares , and ovals to
circles.  Ovals and rectangles can be set to Frame Area (with various
line widths), to Fill Area (which fills the graphic image with black) or to
Erase Area (which fills the graphic image with white).

� Although  dotted lines may sometimes appear distorted on the screen,
they will be drawn correctly when printed on a PostScript laser printer.

Drag from 1 to 2 

Fig. 3.38: Graphic Images in NoteWriter

Importing Graphics
Graphics from other programs (in PICT format) can be included in
NoteWriter documents.  These images may be imported (copied and
pasted) from any Macintosh graphics program.  PICT images are
displayed with dotted lines around them.  As in the case of text boxes,
you can re-position the images by selecting the top-left corner of the
rectangle and dragging the image to a new location.  (The rectangle is
moved without the image until the mouse button is released.)  You
can resize PICT images by dragging the bottom-right corner and
stretching or compressing the picture.

The procedure for importing graphics is as follows:

• Create the picture in any standard Macintosh graphics program (or
on another computer that is capable of saving in PICT format.)

• Copy the picture and paste it into the Scrapbook.
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• In NoteWriter, open the Scrapbook and copy the image by
selecting Copy from the Edit menu.

• Close the Scrapbook and choose Paste from the File menu.
• Drag the PICT (which initially appears as a rectangular region) into

place.
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Symbol Library

Symbol Libraries contain collections of NoteWriter images (including
PICT and text images.)  The Symbol Library normally appears down
the left side of the screen although the window may be enlarged or
moved elsewhere.  The library is divide into numbered segments
(usually 50) with each segment containing an single image or
collection of NoteWriter images.  (Any amount of material can be
placed in each segment of the Library - although only a small portion
may be visible in the library window.)

The operation of the Symbol Library is controlled from the Library
menu:

New Library - creates a new, blank Library, initially set with 50
segments.  (When you paste into the last segment of the Library,
five more segments are added.)

Open Library... - brings up a dialog box with the existing libraries on
the available disks.  Select the Library you want to open.

Save Library... - saves the current Library to disk.

Save Library As... - save the current Library under a new name.

Clicking the go-away box in the Library window hides the Library but
does not close the Library file.  To make the Library visible again,
select Symbol Library from the Windows menu.

Copying and Pasting with the Symbol Library
To copy the contents of a Symbol Library segment to use in your
score, select the segment you wish to copy by clicking the mouse in
the segment.  Choose Copy from the Edit menu (or use -C).  Select
the Paste item from the Edit menu (or use -V) to insert the contents
of the segment into your score.  You may also use the Cut item from
the Edit menu ( -X) to remove the contents of the Library segment.

To paste a collection of NoteWriter images into the Library, select the
images you want to copy (with the Select-Rect or Select-Region tools)
and choose the Copy item from the Edit menu.  Then click on the
segment of the Library you want to store the images in and choose
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Paste from the Edit menu.  If you paste into a segment that already
contains an image, the old image will be replaced by the new one.

Fig. 3.39: Symbol Library
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Chapter 4 - Editing
This chapter deals with the NoteWriter editing routines.  Normally, the
user will switch freely between inserting images and editing the score.
Modifications to the score may be made at any time.

Editing in NoteWriter: An Overview
NoteWriter was designed with a highly interactive and intuitive
user-interface.  Entering images is done by specifying the essential
drawing positions with the mouse, and editing is done by selecting
portions of the score and performing editing procedures on the
selected material.

Most modifications to the score are done by dragging images (or
portions of images) with the mouse.  As the music is altered, the
changes are displayed on the screen  you are always able to view the
current state of your score.

Although editing does not require a knowledge of the underlying
structure of NoteWriter, it is useful, especially for complex editing
situations, to understand how editing is accomplished by the program.
It should already be clear that all images in NoteWriter have Control
Points associated with them, and that for most images these Points
are the cursor positions used to place the image on the screen.
When you select images, you are gathering their Control Points, and
when you perform an editing operation, you are adjusting the Control
Points, causing the appearance of images to be altered.

Selecting Images
As with most Macintosh applications, you must first select the
material you wish to edit, then call the editing procedure.  To select
material in NoteWriter, you can use either the Select-Rect  or
Select-Region  tools.  Click the box in the Command Window top
make one of these tools active.

With the Select-Rect tool, you should position the cursor above and
to the left of the image or group of images to be selected, then hold
the mouse button down and drag the mouse.  As you move the
cursor, an inverted rectangle appears.  When you have enclosed the
images or portions of images you want altered, release the mouse
button.  The Select-Rect tool is a more efficient tool for selecting
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portions of the score and should be used for normal editing.  If you
are using the Select-Rect tool, the document will scroll automatically
if you push the cursor to edge of the window.

Fig. 4.1: Selecting with the Select-Rect tool

� The Return key can be used to switch between Insertion and
Select-Rect modes.

With the Select-Region tool, hold the mouse button down and move
the cursor so that you encircle the image or images you want
selected.  As you move the mouse, a line appears, and when you
release the mouse button, the region you have outlined becomes
inverted.   The Select-Region tool is useful for selecting some images
while excluding other images (whose Control Points are in the same
rectangular area of the score.)  With the Select-Region tool, you can
precisely control which images are selected.

Fig. 4.2: Selecting with the Select-Region tool

When there is no selected area on the screen, the last image entered
is considered to be selected, so you can perform any editing
operations on an image immediately after entering it without having to
change tools and select it.

Adjusting Images
Slight horizontal adjustments can be made to the position of images
with the right and left arrow keys on the keyboard.  The procedure
operates upon currently selected images, or upon the last image
added to the page if there is no selection.  The distance of the
adjustment is 2 pixels, and the procedure can be used repeatedly to
move the images across the page.  The main purpose of this editing
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routine is to quickly adjust images in order to avoid collisions between
notes and accidentals.

The horizontal position of accidentals can be adjusted to avoid
collisions between accidentals in chords.  Select the note or notes
whose accidentals you wish to modify and depress the left or right
arrow keys while holding down the Shift key.  The left arrow causes
the accidental to shift to the left and the right arrow causes them to
shift to the right.  The arrow keys can be depressed repeatedly until
the accidentals are in position.  You can also alter the position of
accidentals by choosing Shift Accidental Left or Shift Accidental Right
from the Note Modifiers sub-menu of the Modify menu.

� Only accidentals that were entered as part of the note (with compound
commands such as "qsh" or with the Modify menu items) can be
re-positioned in this manner.  If accidentals were added as separate
images, they can simply be dragged to a new position.

Selection and Control Points
Some editing routines (specifically Adjust and Stretch-Compress)
operate on all Control Points selected, while others affect only images
whose primary Control Point  (i.e. first Control Point) is selected.  For
the sake of consistency, it is recommended that you enter horizontal
and vertical images (i.e. beams and lines) from left to right or top to
bottom.  If you follow this guideline, you can assume that the top or left
edge of the image is the primary Control Point, and when using editing
routines which require only the first Control Point to be selected, you
can simply the process by selecting a small area around the primary
Control Point rather than selecting the entire image.

� You may display Control Points on the screen temporarily with the
Show Control Points item in the Control menu.  Primary Control Points
are drawn in white, others in light gray.

� As a short cut, when selecting a single Control Point, you can simply
click on the point without dragging the mouse.  A small rectangle is
drawn around the cursor, and the underlying Control Point will be
selected.

Since NoteWriter has been designed to work intuitively, you should
not be too concerned with the positions of Control Points.  When you
select the images or portions of images you want to modify,  the
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appropriate Control Points will be selected.  It is only when images are
in very close proximity that you may want to display the Control Points
before selecting the image.  Figure 4.3 shows a number of selections
on a single note with an indication of what editing procedure might
subsequently be performed.

1. Selecting the note head -- for changing the pitch or the horizontal
placement of the note

2. Selecting the note stem -- for changing the length or direction of the
stem

3. Selecting the entire note -- for moving the note or copying into the
buffer.

Fig. 4.3:  Selecting Portions of an Image.

In the next example, groups of images are being selected and edited.
Notice that any collection of Control Points  regardless of what image
they belong to can be edited simultaneously.

Select noteheads, accent 
and slur 

Adjust selection up 
one staff space 

Fig. 4.4:  Selecting Groups of Images.

Shift-Selecting
If you hold the Shift key down while using the Select-Rect tool, you
can make multiple selections of non-contiguous images.  When you
make a new selection with the Shift key held down, the previous
rectangle changes from being highlighted to a framed rectangle, and
the new area is highlighted.  All Control Points in all of the rectangles
drawn are selected and ready to be operated upon.  However, only
the last rectangle is active, so operations which require that the
cursor to be placed in the selected area will only work when you place
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the cursor in the last rectangle drawn.  This procedure is particularly
useful for modifying notes.  For example, you can Shift-select all the B
pitches on the page and choose the Add Flat menu item to change all
the notes to Bb.

After and editing operation, all areas remain selected for further
editing.  They automatically become un-selected when you change
tools, or enter a new command in the Command Line.
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The Edit Menu

Fig. 4.5 The Edit Menu

Undo
The Undo routine is an extremely useful procedure and should be
used to repair any mistakes made during insertion or editing.  The last
change to the document is un-done, and the screen is redrawn in its
previous state.

To call Undo, you may either select Undo from the Edit menu or use
the -Z keyboard short-cut.  You are strongly urged to use this
routine frequently -- it is a clean and efficient way of fixing errors   in
many cases it is faster to Undo an incorrectly placed image and
redraw it, than to move the image to its correct location.

Copy
In accordance with Macintosh editing conventions, you must first
select the material you want copied (with the Select-Rect or
Select-Regions tools), then perform the operation.

To copy a selected area or region, choose the Copy item in the Edit
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menu or use the -C short-cut.  All images whose primary Control
Point has been selected are copied into the NoteWriter buffer.  These
images may be pasted elsewhere in the score, into another
NoteWriter document, or into the Symbol Library.  At present, it is not
possible to transfer NoteWriter data directly to other applications - to
do this you must save the document either in Paint or PostScript
format.

It is important to remember that NoteWriter does not collect all the
images that are partially enclosed in the selected area, only those
whose primary Control Point has been selected.  In the following
example, the four notes, the beam, the slur and the second tie have
been copied. The staff, the first note, the last note and the first tie are
not included in the copy.

1. Original 2. Select and Copy 

3. Contents of the Buffer 
Fig. 4.6:  The Copy Procedure

Cut
A Cut is performed either by choosing Cut from the Edit menu or by
typing the -X short-cut.  All images whose primary control point is
within the selected area are loaded into the NoteWriter buffer and are
removed from the screen.  Any image (including a staff or a text box)
may be removed from the document.  Removing a staff does not
remove the notes that were on the staff unless they also were
selected.  An incorrect Cut can be reversed with Undo.

Delete
Selecting a area of the score and pressing the Backspace (or delete)
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key removes all images whose primary Control Point has been
selected.  Unlike Cut, the images are not loaded into the buffer.  An
incorrect Delete can be reversed with Undo.

Erase
In addition to Delete, you may erase images by selecting the Eraser
tool  from the Command Window, placing the cursor (which becomes
a white square) on the first Control Point  of an image and pressing
the mouse button.  While the mouse button is down, all images whose
primary Control Point is under the cursor will be removed from the
document.  You may reverse the Erase with the Undo command.
Delete and Erase essentially perform the same task, but their method
of operation is different.

Paste
When the Paste menu item (or -V) is chosen, the contents of the
buffer appear in an inverted rectangle on the screen.

You should place the cursor in the inverted rectangular area and drag
the images to the desired location.  If you reach the edge of the
window while dragging, the document will automatically scroll .

When images are dragged during the Paste procedure, they are
drawn without ledger lines.  When the mouse button is released,
ledger lines are drawn from each note to its closest staff.  If a note
becomes associated with the wrong staff, you can correct the error by
selecting the note and choosing the Next Staff  or Previous Staff
menu items.

1                          2                     3 

Original        Paste and Drag      Result 
Fig. 4.7:  The Paste procedure.
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Adjust
The Adjust editing procedure is the most powerful and useful of all.
This routine allows you to modify the position of an image easily and
precisely.

Although there is an Adjust item in the Edit menu, the normal method
of invoking the procedure is to select an area (or region) of the
document, and simply place the mouse in the selected area and hold
down the mouse button.  As you drag the mouse, all collected Control
Points will be adjusted correspondingly.  Since Adjust operates on all
the Control Points selected, the routine can be used to alter any
image in any reasonable way.

For example, if you select a note head and adjust it, you will cause the
pitch to change, but the stem will still be drawn to its original vertical
location - you have not altered this Control Point.  Likewise, if the end
of the stem is selected, the height or direction of the stem can be
altered without changing the pitch.  If you select the second Control
Point of a slur, the arc and direction of the slur can be altered without
affecting the start and end points.  Of course, it is also possible to
collect all Control Points of an image (or many images) and cause
entire objects or groups of objects to be moved.  If you drag images
past the edge of the window, the document will automatically scroll.

After an Adjust, the images can be returned to their original position
by selecting Undo from the Edit menu.

Fig. 4.8: Adjusting Images

� The direction of adjustment can be constrained to the horizontal or
vertical axes if the Shift key is held down when the mouse button is
placed in the selected area.

Move
Move is very similar to Adjust except that the position of entire
images rather than portions of images are altered.
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You may use the Move menu item in the Edit menu, or you may
simply select an area, place the cursor in the area, and depress the
cursor button with the Option key held down.  As you drag the mouse,
the all images whose primary Control Point has been selected will be
moved with the cursor.  As in the case of Adjust, the Shift key
constrains the drag to horizontal or vertical axes.  Images altered with
this procedure are moved without changing their relative coordinates
in other words, the object or objects are moved as a block.  You can
return the images to their original position with the Undo menu item.

� Although Adjust (with all Control Points selected) can be used to Move
images, you will get more reliable results if you use the Move procedure
when you are relocating a block of images.

The example below (Figure 4.9) shows the distinction between Adjust
and Move.  The same area (enclosing a single note and the right
edge of a beam) is selected in both cases.  Notice that Adjust allows
the note to be moved and the beam to be stretched, while Move
causes the note to moved without the modifying the beam (since only
its second Control Point was selected).  In fact, the Move could have
been done with only the note head selected.

Selection          Adjust                Move 
Fig. 4.9:  Distinction between Adjust and Move

Stretch / Compress
This procedure causes the images within a selected area to be
adjusted proportionally.  This routine is very useful for adjusting the
score so that the music is aligned at the right margin.  The procedure
is analogous to full justification in a text editor.  It allows you to alter
the spaces between images without altering the shape or size of the
images themselves.  To perform a stretch or compress, select the
material to be adjusted, then choose Stretch-Compress (  - K) from
the Edit menu, then place the cursor in the selected region (towards
the right edge of the selection).  As you drag the mouse, the images
will be adjusted horizontally according to their proportional position
within the selected area.  Conceptually, you should consider the
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cursor position to be the new right edge of the selected area:  as you
drag to the right, the selected images will become further apart, and
as you drag to the left, the images become closer together.  Vertical
movement of the mouse is ignored.  When the Grid is on, all
stretching and compressing is aligned to the Grid.  The following
example demonstrates how a group of notes can be stretched so that
they fill the entire measure.

1. Original Image 

2. Select and place  
cursor at the right  
edge of the area 

3. Drag mouse and  
release the button 

Fig. 4.10: Stretching a passage.

� If accidentals and dots were added as separate images, they will be
stretched and compressed away from their associated notes.  If they
were entered as part of the note (with compound commands such as
"qsh" or with the Modify menu items) they will remain in the correct
position relative to the note.

Justify
As an extension to the Stretch / Compress operation in NoteWriter,
there is a Justify menu item (in the Edit menu) which can be used to
stretch or compress a line or system of music so that the last barline
is aligned with the right edge of the staff.  To justify a line (or system)
of music, follow the procedure outlined below:

1 Enter a line or system of music WITH the final barline (which may
be before or beyond the right side of the staff).

2 Set Select to Right Edge using the menu item in the Edit menu and
select all the notes on the staff or system (drag the cursor on the
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left of the first note on the staff).
3 Select the Justify item in the Edit menu.  The right-most barline will

be aligned to the end of the staff, and all other images adjusted
proportionally.  If a barline (or double-barline) is not the right-most
image, the last image is placed a short distance to the left of the
end of the staff.

Making Large Selections
The Edit menu has two items which alter the operation of the
Select-Rect tool.  If you set the Select to Right Edge feature (by
choosing it in the menu), the Select-Rect tool will automatically
enclose the area from the cursor position to the right edge of the
page.  This feature is extremely useful for selecting entire lines of
music in order to extract parts from a score.  Likewise, setting the
Select to Bottom Edge feature will cause the selection rectangle to be
drawn from the cursor to the bottom of the page.  You should turn
these features off (by selecting the menu item again) when you are
finished using them.

� When there is no selected area on the screen, the last image entered is
considered to be selected. You can then perform editing operations
after entering an image without having to select it.

This feature also works for copy and cut, so that an image may be
placed on the screen and immediately copied.

� If you set both the Select To Right Edge and Select to Bottom Edge
features, you can select the entire score by simply clicking in the
top-left corner of the document.

Remove Last Image and Reinstate Last Image
Selecting the Remove Last Image item from the Edit menu removes
the last image in the data structure.  Unlike Undo, you may continue
calling this routine and remove additional images from the document.
Reinstate Last Image is the complementary routine -- it sequentially
restores the removed images.  These routines can be used to
eliminate or restore the most recent additions to the score.  For
example, if you add an image, then select Undo, you can undo the
undo by selecting Reinstate Last Image.

88   Chapter 4: Editing 



! The Remove Last Image procedure cannot remove Text boxes - they
must be erased or deleted.

Set / Clear Edit Filter
An Edit Filter is provided for instances (such as transposition) where
certain images ( e.g. barlines and rests) should be left where they are,
while other images (e.g. notes, beams, slurs etc.) are moved.
Selecting the Set Edit Filter item causes a dialog box to appear with a
series of image types listed (e.g.rests, barlines etc.). Setting these
items causes the associated images to be omitted from cut and copy
selections.The Clear Edit Filter item clears the current filter settings.

Fig. 4.11: Edit Filter
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The Modify Menu

Fig. 4.12: Modify Menu and Submenus

Modifying Images
In addition to the routines outlined above, there are a number of items
in the Modify menu which can be used to alter the characteristics of
images or collections of images.  Like the Edit procedures, you must
first select the material to be modified before calling the routine.  All
images whose primary Control Point is selected will be modified.

Beam Notes
The Beam Notes menu item in the Modify menu allows for automatic
beaming of selected notes.  The procedure (invoked by choosing the
menu item or Control-B) causes all selected flagged notes (8th, 16th,
32nd and 64th notes) to be altered to a beamed group.  The routine is
capable of joining up to 32 notes in a group.  The main beam is drawn
from the end of the flag on the first note to the end of the flag on the
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last note, with all intermediary beams being calculated accordingly.
This routine can be a tremendous time-saver when used in
conjunction with the on-screen keyboard and Vertical-Alignment Bar
since it allows you to enter notes with flags, and form them into
beamed groups later.

� Remember that the main beam is drawn from the tip of the flag of the
first note to the tip of the flag of the last note in the selected group.
You should normally ensure that the positions of the flags are
appropriate before beaming the group - the stems of the outside notes
will not be adjusted.

It is also possible to have beams automated added while you are
entering notes.  Refer to the section on Auto-beaming in Chapter 7 for
more details.

The UnBeam Notes menu item ( -H) in the Modify menu changes
notes which have previously been beamed with the Beam Notes
menu item into flagged notes.  Both the notes and the beams should
be included in the selection  -  if the beam is not included, it will remain
on the screen even though the notes are altered.

Flip Beam or Tie

For Beams:
This procedure (in located in the Modify menu) allows you to reverse
beams that have been drawn in the wrong vertical direction by default.
The position of the beam is not altered, merely the side of the beam
on which secondary beams are drawn (i.e. above or below the main
beam) .  It is possible with complex beams (i.e. beams which are
constructed with multiple segments) to change the direction of some
of the beam segments and not others.  In the example below, all
beams were originally drawn in an upward direction.  The middle beam
segment (the second group of sixteenth beams) was selected and the
direction changed.

Chapter 4: Editing    91

Fig. 4.13:  Flipping the Direction of a Secondary Beam.

For Ties:
This feature is intended to be used in conjunction with the Tie Notes
menu item to reverse the drawing direction of ties.  Select the left
edge of the tie (i.e. the primary Control Point), then choose this menu
item.  A downward tie will flip to the other side of the note and be
drawn in an upward direction, and vice versa.  This procedure may
also be used with slurs, although the position of the altered slur may
still require some adjustment.

Transpose
A number of transposition features are present in NoteWriter: Free
Transpose, Interval Transpose and Key Transpose.

! Transposition will only work properly when accidentals are associated
with notes.  If you have added accidentals as separate images the
notes they refer to will be treated as if the accidental is not present.

Free Transposition
To perform a transposition (by interval) on a portion of your score,
select the material to be altered , choose the Free Transposition
menu item ( -U), place the mouse in the selected area and drag the
mouse up and down.  As the mouse is dragged, the notes will be
altered to different transposition intervals.  Release the mouse button
once the desired pitch level has been reached.  Staves, barlines,
rests, dynamic markings, etc. will be unaffected by the transposition.
Slurs, ties, beams and articulation marks will be adjusted with the
notes.

� Notes are adjusted to include all normal pitches.  Therefore, many
semitones have two enharmonic equivalents.  The note C when
ascending will appear as:

C - C# - Db - D - D# - E - F - F# - Gb - G - G# - Ab - A - A# - Bb - B
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Transpose Interval
To transpose a passage by a a specific interval, select the material to
be transposed and choose the Transpose Interval... menu item.  A
dialog box allows you to set the transposition interval and direction.

Fig. 4.14: Transpose Interval Dialog

Transpose Key
To transpose a passage from one key to another, select the
Transpose Key... menu item.  A dialog box appears which allows you
to set the original key, the destination key and the direction of
transposition.  The selected notes will be transposed to the new key.
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Fig. 4.15: Transpose Interval Dialog

This procedure does not change the key signatures.  This must be
done by deleting the old key signature and entering a new one -- using
the key signature commands (eg. ks2) or the global key signature
command (eg. &ks2).

! Since all transposition is done relative to the clefs, clef changes from
the original page setup may result in incorrect transposition.  When no
clef has been entered on a staff, a treble clef is assumed.

Clean Up Accidentals
Since NoteWriter scores are not organized into measures, there is no
simple way of avoiding repeated accidentals within measures.  When
transpositions are performed, there may be repeated accidentals or
missing naturals.  The Clean Up Accidentals menu item is designed
to eliminate these errors and redundancies.  Select the area to be
altered (usually one measure - including multiple staves) and choose
the Clean Up Accidentals item.  Repeated accidentals will be
removed, and any required naturals will be added.  If you prefer, you
may manually correct the errors using the Add Accidentals and
Remove Modifiers menu items.
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Previous Staff  and Next Staff
These menu items cause the selected notes to be associated with
the closest staff above or below the staff to which they are currently
associated.

If ledger lines appear connecting the note to a staff other than the one
you intended,  use these items to change the staff association and
thereby remove the ledger lines.  Incorrect association may occur
during editing (e.g. if you move a note from one staff to another rather
than cutting and pasting.)

! Since staves are considered to extend across the entire width of the
document, you may find that staff associations become confused if you
have two short staves at approximately the same vertical location.
Adjusting the staff position so that it is directly in line with the other
staff should resolve the confusion.  Alternatively, you may use the
Previous Staff and Next Staff items to associate the notes with the
correct staff.

Remove Ledgers and Add Ledgers
These items, as their names suggest, remove or add ledger lines by
either canceling any staff association or creating an association with
the closest staff. To stop ledger lines from being added automatically,
disengage the Defaults.

Remove Modifiers
The Remove Modifiers ( -M) item in the Note Modifiers submenu
eliminates accidentals and dots (i.e. modifiers) from all selected
notes.

Add Accidentals
The Note Modifiers submenu includes items for adding accidentals
(double sharps, sharps, naturals, flats and double flats) to selected
notes and for adding a dot to selected notes or rests.  Accidentals
appear in a fixed position to the left of the notes.  If this position
causes a collision with another accidental, then you may move the
accidental with the Shift-Left arrow or Shift-Right arrow keys or
choose the Shift Accidental Left or Shift Accidental Right menu items.

In some cases, it may be faster to enter notes without accidentals,
then to move through the score Shift-Selecting all the notes which
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require a certain accidental, then choosing the appropriate menu item.

Fig. 4.16:  The Effect of Add Dot.

Add Articulations
The Note Modifiers submenu includes items for adding staccato
dots, accents or tenutos to selected notes.  The articulation marks
are placed at a set distance above noteheads whose stems or flags
are down and below noteheads whose stems or flags are up.  If
desired, you can add both staccato dots and accents or staccato
dots and tenutos to the same notes.  Added articulations are
considered as separate images, so they can be freely moved,
removed and edited.

Change Note Values
The Note Values submenu contains menu items (Change to Quarters,
Change to Eighths and Change to Sixteenths) that allow you to
change the durations of selected notes respectively to quarter notes,
eighth notes and sixteenth notes.  The Double Note Values item
changes the note values of selected notes so that they are twice their
original duration.  The Halve Note Values item changes note values
so that they are half their original duration.  Although the appearance
of notes may change, none of these menu items alter the position of
the notes.

� This feature will only work properly on notes that have not been formed
into beams since notes that have been beamed are considered to be
quarter notes.

Tie Notes
This procedure was added to automatically tie notes together.  Select
the two notes to be tied, then choose the Tie Notes menu item ( -T).
If you have selected more than two notes, only the first two notes will
be tied.  The direction of the tie is determined by the stem direction of
the first note.  If the tie is drawn in the wrong direction (i.e. when there
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are multiple voices on the staff), you may reverse the direction by
selecting the tie and choosing the Flip Beam or Tie menu item ( -I).
Also, ties may be adjusted or moved using the normal editing
procedures.  Remember, ties are drawn to and from the same vertical
location -- they cannot be used to join notes of different pitch.  If you
adjust the first or third Control Point of a tie the other will be adjusted
with it.

� This feature may only be used to generate ties between notes.  To draw
ties at the ends or beginnings of lines, use the normal tie command.

Flip Notes
This menu item ( -J) causes a group of selected notes and beams
to be flipped so that the beams and stems are drawn on the opposite
side of the note heads.  In effect, the stems are flipped, the beam is
shifted, and the drawing direction of the beam is reversed.  This
routine may not work correctly with excessively long stems or unusual
melodic contours.  All images may, of course, be altered using the
normal editing procedures.

! If the beam becomes separated from the notes when you perform this
routine, it means that beam was initially drawn in the wrong direction
(in the case of single beams, this is not apparent on the screen.)  You
should first reverse the direction of the beam (Change Beam Direction
menu item) then call the Flip Beams and Stems routine.

Select Area                 Flip Notes 
Fig. 4.17:  Flip Beams and Stems
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The Extension Menu
An Extension menu (named Ext.) was added to NoteWriter so that
simple, but useful editing procedures could be added to the program
as they were developed, and so that individuals could customize their
version of NoteWriter with additional editing routines.

A number of these routines have been added (thanks to George Kan
for writing most of them):

Remove Dot - removes only the dot from selected notes and rests.

Remove Accidental - removes only the accidental from selected
notes.(The Remove Modifiers menu item removes both
accidentals and dots.)

Remove Stems - removes the stems from notes.

Remove Heads - removes the notehead leaving only the stem.

Change Note->diamond - change a regular notehead to a diamond
notehead.  This is useful for string harmonics.

Change Tie->dotted - change a tie or slur to a dotted curve.

Change Note->small - change selected regular-sized notes to grace
notes.

Align horizontal - align images horizontally (to the first image in the
selection.)

Tie Middle Up - adjusts the arc of the tie so it is higher.  In fact, the
tie is transformed into a slur and the middle point is adjusted.

Tie Middle Down - adjusts the arc of the tie so it is lower.  As above,
the tie is changed into a slur and the middle point is adjusted.

Move 1Pix->right - move images 1 pixel to the right.

Move 1Pix->left - move images 1 pixel to the left.

Move 1Pix->down - move images 1 pixel down.
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Move 1Pix->up - move images 1 pixel up.

� The above 4 items allow you to adjust the position of images without
disabling the Grid.

Line Width... - brings up a dialog box which allows the width of lines
and other graphics (rectangles, ovals, curves) to be altered.

Text... - allows the characters in single-quote text to be altered.  (Up
to 8 characters are allowed in single-quote text.)

Text Size... - allows the size of single-quote text to be altered.

Time Signature - allows selected time signatures to be altered.

Change Object - allows the ID number of a selected image (or group
of images) to be altered.  This should only be done by expert
users!

Cresc.<->Dim. - alters the direction of selected crescendi and
diminuendi.

Users who are familiar with C programming and would like to create
their own editing extensions should contact the author for the
necessary code.
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Chapter 5 - Printing
Printing Modes
NoteWriter supports two printing modes: Draft mode is designed for
dot matrix printers, ink-jet printers and non-PostScript laser printers.
Laser mode is designed for PostScript laser printers and
phototypesetters.  To print in Draft mode, select the Draft-quality
Print... item from the File menu.  To print in laser mode, select the
Laser Print... menu item ( -P) from the File menu.

The main distinction between the two printing methods is that Draft
mode sends the images on the screen to the printer as QuickDraw
calls, while Laser mode converts the images on the screen into
PostScript code and sends this code to the printer.  The PostScript
printer then interprets the code and draws the music images using the
Sonata font and high resolution methods for beams, slurs, and other
variable length images.  The output of Laser mode (PostScript)
printing is far superior to Draft mode printing.  However, because of
the difference between the two printing modes, the screen will be
faithfully reproduced with Draft printing, but is approximated (as
closely as possible) with Laser printing.  You will notice some slight
discrepancies between what appears on the screen and what
appears on your PostScript laser printer.  For the most part, the
discrepancies result from the differences between the NoteWriter
images (on the screen) and the Sonata images (on the printer) as well
as from the different methods (PostScript versus QuickDraw) used to
draw variable length images (e.g. slurs, ties, piano braces.)  If you are
working with very detailed and precise placement of images, you may
be required to make slight adjustments to the screen images so that
they appear exactly the way you want them on your PostScript printer.

Another important distinction between the two printing modes is that
Draft printing sends the enlarged images to the printer, whereas
Laser printing sends the images at normal scale (24 point).  The best
way to conceptualize this is to consider the screen to be slightly
magnified - notice that the NoteWriter rulers (choose the Ruler On
menu item) are also enlarged.  When you print in Laser mode, the
images are automatically reduced to normal size, but when you print
in Draft mode they remain enlarged, unless you choose the Draft Print
@ 75% selection from the File menu.
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Page SetUp
Choosing Page Setup from the File menu shows the standard
Macintosh dialogs for the currently selected printer.  A dialog box
appears which allows the paper size, the orientation and other special
effects to be specified.

5.1: LaserWriter Page Setup dialog.

Once a Page Setup has been set, you should see the print area
margins on the screen - a gray rectangle on the main screen shows
the current print area and will reflect all the setting of the Page Setup
dialog.  This gray rectangle can be turned of with the Hide Print Area
menu item in the Control menu .

To view a miniature display of the entire page choose Show Overview
( -F) from the Windows menu.  The print area (as set by the Page
Setup dialog) is highlighted and can be moved to any desired location
by dragging it.  This allows you to change to portion of the score that
will appear on the printed page.
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Fig. 5.2: Overview of the Page

� Page Setup information is saved with the NoteWriter file.  If you move
your document to another computer or try to print on a different printer,
you should choose Page Setup before trying to print the document.

Draft Printing
To print a Draft-quality copy of your document, select Draft-quality
Print from the File menu.  A dialog box controls the printing job.  If you
are printing on an Apple ImageWriter it is recommended that you use
the Faster rather than the Best quality setting in this dialog box.  Best
quality prints lines darker than bitmaps, and the output will not be
consistent.

5.3: ImageWriter Print Job Dialog Box

Draft mode was primarily designed for proofing scores on dot-matrix
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or ink-jet printers, although it may be used for final copy if a PostScript
laser printer is unavailable.  In order to produce a reasonably high
quality output on dot matrix printers, the images are sent to the printer
at the size they appear on the screen.   The printed score can later be
reduced to a smaller size (e.g. to 75%) with a photocopier to
produces a much more acceptable resolution than printing at the
smaller size.  However, because an enlarged version of the score is
sent to the printer, you may not get the entire document on a single
page.  Alternatively, you can choose Draft Print @ 75% from the File
menu to reduce the score so that it fits on a single page.  The chart
below shows the actual printing area on the page, and the effective
size of the NoteWriter document that is printed in this area.

Paper Actual Size Document Size
Letter 8" X 10" 6.75" X 7.75"
Legal 8" X 14" 6"  X 10"
Computer 10" X 14" 7.75" X 10"

Most dot-matrix and ink-jet printers permit a variety of reduction and
enlargement percentages, so you may want to experiment with
different percentages (with and without the Draft Print @ 75% item
checked) in order to get the desired print-out size on the paper.

 Laser Printing
To print on a PostScript printing device such as the Apple
LaserWriter, choose Laser Print... ( -P) from the File menu.  The
Page Setup dialog box allows you to specify either landscape or
portrait orientations, reductions and enlargements of 25% to 400% as
well as several other options such as larger print areas, printing in
gray scale, multiple page layout, etc.

If you are having difficulty printing on a PostScript printer, ensure that
you have the most recent version of the printer driver in your system
folder.  The printer driver should be included on the disks that came
with the printer.

Most recent printer drivers spool the print job on your hard drive
during the printing process.  You should always ensure that you have
at least 2 MBytes free on your hard drive when printing NoteWriter
documents. Very large or dense documents may require even more
memory to print.
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5.4:  LaserWriter Print Job Dialog Box

! If you select Laser Print... with a non-PostScript printer connected, a
message will notify you of the printer incompatibility.

There are endless printing possibilities with the various page sizes,
paper sizes, reduction percentages and tiling configurations in Laser
mode.  Basically, you can print any size document many different
ways depending upon the resolution you want.  Remember, laser
printers have a fixed resolution (eg. 300 dots per inch or 600 dots per
inch) -- as you reduce the score, you lose clarity.  For miniature
scores, photocopy reduction of a larger page may produce a better
result a than a drastic laser printer reduction.  The table below shows
the document size and the reduction percentage which fits on a single
page of letter size paper.  The document sizes assume a 1/2 inch
margin on all sides.  With tiling, you may use multiples of these sizes
(e.g. 16" X 11").

Document Size Reduction % Orientation
8.5" X 11" 100 Portrait
9.5" X 12" 90 Portrait
10.5" X 13.5" 80 Portrait
11" X 14.5" 75 Portrait
12" X 15.5" 70 Portrait
14" X 18" 60 Portrait
11" X 8.5" 100 Landscape
12" X 9.5" 90 Landscape
13.5" X 10.5" 80 Landscape
14.5 " X 11" 75 Landscape
15.5" X 12" 70 Landscape
18" X 14" 60 Landscape

The same principle can be applied to enlargements.  To print at 125%
(with portrait orientation) the recommended document size is 6.5" X
8.5".
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Tiling
Tiling is the process used to print a large document in pieces so that
they can be taped together to recreate the original large page.  Since
most laser printers (including the LaserWriter) cannot print on paper
larger than legal size, this procedure is necessary for printing
orchestral-sized scores.

� If you have access to a large-format laser printer, it is possible to print
large pages either with a specialized driver for this printer or through a
page layout program.  The procedure for transferring NoteWriter files to
page layout programs is discussed in Chapter 8.

Whenever you print a document, the area of the page that will be
printed is determined by the rectangular area that is highlighted when
the Show Overview window is displayed.  Any portions of the score
that are outside this rectangular area will not be printed.  In order to
print the portions of the document that outside of this area, you must
either change the reduction percentage (in the Page Setup dialog) so
that the entire document is within the rectangular area or you must
print the page in several pieces. To print the document in several
pieces, you should print the first part of the score with the print area
(i.e. the highlighted rectangle) placed at one location of the document,
then adjust the print area (by dragging the highlighted rectangle) to a
different location and print this portion of the document.

Printing Large Pages
As an example, we will run through the procedure for printing a 10" X
15" document in two tiles (at full size).

• select Show Overview from the Windows menu and set make sure
the print area is positioned at the top of the page.

• print the document (using landscape orientation at 100%)
• select Show Overview again (if it the Overview window is not

already visible) and drag the highlighted rectangle (i.e. the print
area) half way down the page - allow for at least 1" of overlap
between the two areas.

• print the document again (also using landscape orientation at
100%)

• Tile (tape) the two portions of each page together.
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Obviously, the entire document could have been printed on a single
page (portrait orientation) at 70% or 75% reduction.

A Note Concerning the Printing of Large Pages:
When printing large documents in pieces on certain laser printers (eg.
early version of the Apple LaserWriter), you will find that the images
at the bottom of one page do not align accurately with the top of the
next page.  This is a problem with the optics of the LaserWriter -- lines
drawn on either side of the page are not perfectly parallel.  The
problem is especially noticeable on Legal-size paper printed in
landscape orientation.  One way of minimizing the distortion is to print
the first page normally, then print the second page with the Flip
Horizontal and Flip Vertical options set.  Alternatively, you can control
the position of the overlap between adjoining pages so that relatively
few images cross from one page to another (in an orchestral score,
this means splitting pages between systems or orchestral groups).

Changing the Page Size
To change the document page size during editing, select the Change
Page Size  item in the Control menu and enter the new size.  Images
on the score are not affected by the change to the document size.

If you are increasing the score size, the staves should be extended
manually by selecting their right edge (Control Point 2) and adjusting
them to the new margin.   If you are reducing the score size, you
should first remove or adjust any images which will be outside the
new margins (eg. the ends of staves should be adjusted to the left).

Postscript Settings
A PostScript Settings dialog box can be found in the Control menu.
This dialog box sets a number of PostScript variables which alter the
appearance of the certain images when the document is printed in
Laser mode.  The settings for Beam Thickness and Distance between
Beams are reflected on the screen, the others are only apparent
when the page is printed.  These settings are not saved as part of the
document, but may be saved in your NoteWriter preference file by
choosing the Save Preferences... item from the File menu.

Currently, the attributes which can be set are:
1) Beam Thickness   (3, 4 or 5 pixels)
2) Distance between Beams  (4, 6 or 8 pixels)
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3) Slur and Tie thickness (max thickness = 2, 2.5, or 3 pixels)
4) Curly Brace Thickness (Thin, Medium or Thick)
5) Staff Line Thickness (.25, .5, or .75 pixels)
6) Standard Line Thickness (.5, .75, or 1 pixel)

Fig. 5.5: PostScript Setting Dialog box

The examples below show beams and slurs at different PostScript
settings:
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Fig. 5.6:Thick Beam and Slur Settings
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Fig. 5.7:Thin Beam and Slur Settings

PostScript Files
As well printing your documents directly from NoteWriter, you can
save your scores (or excerpts of your scores) as Encapsulated
PostScript (EPS) files.  EPS files can be imported into most word
processors and page layout programs (eg. Microsoft Word and Aldus
PageMaker) and the NoteWriter excerpts can printed from these
applications.  For more information on Encapsulated PostScript files
refer to Chapter 8.
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Chapter 6 - Alignment Aids
There are a number of devices which aid the user in correctly
spacing and aligning your music.  Ultimately, however, every image is
adjustable and moveable whether or not alignment aids are used
during input.

Ruler
The NoteWriter ruler can be turn on and off with the Ruler item ( -R)
in the Control menu.  It is drawn along the top and left edge of the
Score Window, and shows the current position of the window within
the document.  The Ruler is always drawn from the original origin of
the document (i.e. top-left corner of the page).  The maximum height
and width of the ruler is 36 inches. or 90 centimeters.

� To change the measurement units from inches to centimeters, use the
Set Ruler... menu item in the Control menu.

Fig. 6.1:  NoteWriter Ruler

As you move the cursor, horizontal and vertical pins (short dotted
lines) appear in the ruler at the current position of the cursor.  These
pins may be used to help align images, or to aid in the spacing of
images on the page.

� The Ruler has been enlarged to correspond to the NoteWriter screen
images.  Inches on the ruler are 25% larger than normal.
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Grid
The Grid is an automatic adjustment feature.  When the program is
launched, the Grid is engaged, although it may be turned off and on
with the Grid item in the Control menu ( -G).  The Grid is invisible,
and is set to 4 pixel X 4 pixel squares. The function of the Grid is to
alter the positions of most images slightly so that they are aligned with
other images. For example, when a note is entered, the Grid ensures
that it is centred either on a staff line or in a staff space.  When a
beam is entered, the Grid adjusts it horizontally so that it meets the
note stem.  Editing commands, (e.g. Adjust, Move, Paste) also leave
images aligned to the Grid.

If you do not want note heads and other images to be correctly placed
on staff lines and spaces, or you want more precision when moving or
adjusting a portion of score, the Grid may be turned off, and all
objects freely positioned.  If you notice that beams and notes are not
properly aligned, it may be that the Grid was not enabled when these
images where drawn.  The incorrect images should either be
re-drawn with the Grid on, or adjusted to their correct position with the
Grid off.

! Because of the resolution difference between the Macintosh screen and
High-quality printers, it is possible that two images may appear to be
joined on the screen, but be a short distance apart when printed.  To
avoid this discrepancy, keep the Grid on except when it is absolutely
necessary to remove it.

Defaults
Defaults are a collection of preset alignment tendencies.  They are
initially enabled, but may be turned on and off with the Defaults item in
the Control menu ( -D).  Defaults cause some music images to be
adjusted to their standard position on or relative to the closest staff.
In keeping with the basic philosophy of NoteWriter, the Defaults may
be disengaged at any time.  When Defaults are active, the following
symbols are adjusted in the following ways:

Rests -- all rests are adjusted vertically to their standard position on
the closest staff.  If the Vertical Alignment Bar is also engaged, the
horizontal position of the rest will be adjusted to the V.A. Bar.

Clefs -- all standard size clefs are adjusted vertically to their normal
position on the closest staff.
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Barlines -- barlines, double barlines and repeat barlines are adjusted
so that they connect the top line of the top staff with the bottom line
of the bottom staff in the closest system.  If Defaults are disabled,
barlines will be drawn the height of a single staff down from the
cursor position.

Global Barlines -- global barlines are normally drawn between all
established systems.  With Defaults disabled, single barlines will
be drawn on all staves of the page at the horizontal location of the
cursor.

Beams --  the direction in which beams are drawn is automated when
Defaults are engaged.  The system looks at the first cursor position
and draws the beams in an upward or downward direction
depending upon the first mouse click relative to the middle line of
the closest staff.  If the first mouse click was above the middle line,
then the beams are drawn in a downward direction, and vice versa.
If Defaults are disabled, upward drawing direction for beams (i.e.
beams below notes) is specified with the commands "bb", "aa",
"gbb" and "gaa".  When adding beams to notes that are in extreme
registers, remember to place the beam on the opposite side of the
middle staff line.

Notes -- when Defaults are disabled, ledger lines are not
automatically added to notes.  Ledgers may later be added with the
Add Ledgers menu item, or with the "l" Command.

! All of the above Defaults are turned off when the Disable Defaults menu
item is selected.  As in the case of the Grid, it is recommended that the
Defaults normally be left enabled, and disabled only when needed.

Vertical Alignment Bar
The Vertical Alignment Bar (V.A. Bar) consists of a dotted line
running the entire length of the page with a box affixed to the line, and
positioned on one of the staves.  It is activated by the Alignment item
in the Control menu (  - L).  While active, all notes and rests will be
adjusted horizontally so that they appear at the position of the V.A.
Bar regardless of where the mouse was originally clicked.
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Fig. 6.2:  Vertical Alignment Bar

There are six methods of moving the Vertical Alignment Bar
horizontally:

• When you depress the Space bar, the V.A. Bar shifts to the right
the distance specified in the Alignment dialog box  (choose Set
Alignment...  from the Control menu).  Holding the Shift key down
and depressing the space bar will shift the V.A. Bar to the left.

• When you depress the Tab key the bar will move to the right a
multiple of the space bar increment (the multiple -- X 4, X 6 or X 8
is also determined by the Set Alignment... menu item).  As above,
Shift-Tab moves the Bar to the left.

• You may use the Back-quote key or the Shift and Back-quote keys
to move the bar by its smallest increment (4 pixels) to the right or
left.  This is useful for making fine adjustments to the position of the
V.A. Bar.

� The Back-quote key (‘) also has the tilde (~) character on it and is
located different places on different keyboards - sometimes it is
immediately to the left of the spacebar and sometimes it is the top-left
key on the keyboard.

• You may place the cursor in either of the black circles which are
centred on the vertical line and drag the Bar to a new position.

• Although not yet discussed in the manual, it is possible to move
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the V.A. Bar with the Keyboard controls in the Keyboard Window.
The left and right arrows shift the Bar increments to the left and
right.

• The Auto Increment item can be selected from the Control menu.
This feature causes the Vertical Alignment Bar to move
automatically after a note or rest has been added.  The distance of
the increment is a multiple of the current Alignment setting
(determined by the Set Alignment menu item.)  The increment
distances are as follows:

Sixteenth note - Alignment setting
Eighth note - 2 X Alignment setting
Quarter note - 4 X Alignment setting
Half note - 8 X Alignment setting
Whole note - 16 X Alignment setting

(Smaller rhythmic values are set to short default distances.)

To shift the Vertical Alignment Bar up and down the page, click on the
small arrows in the top-right and bottom-right corners of the Vertical
Alignment box.  If you click on the up arrow, the V.A. Bar shifts to the
staff immediately above the current staff and if you click on the down
arrow, the V.A. Bar shifts to the first staff below.  The visible portion
of the document is adjusted so that the new staff appears on the
screen.

! If you input images and you don’t see them on the screen, check to see
whether the V.A. Bar is on.  If the V.A. Bar is situated at the very edge of
the window, the notes and rests appearing at this position may be only
partially visible.

Vertical and Horizontal Guides
The function of Vertical and Horizontal Guides is to aid in the
alignment of notes,  rests and other images in a large score.
Essentially, the guides are dotted lines which run the entire height or
width of the document.  They are placed on the document by selecting
either the Vertical Guide tool or the Horizontal Guide tool and clicking
the mouse at the position you want the guide drawn. Guides are
aligned to the Grid when the Grid is enabled.  You can remove
individual Guides by selecting the tool again and clicking on an
existing line, or you can clear all the guides on the page by clicking on
the small square in the upper-right corner of the Guide tool box.
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In practical terms, Vertical Guides are useful for placing a marker at
each beat or sub-beat within a measure.  In the example below,
Guides have been placed at the beginning of each of the three beats.
If you were to scroll down the page, the dotted lines would mark the
horizontal position of these beats.

Fig. 6.3: Vertical Guides

Vertical Guides are also useful for aligning barlines and margins.  For
example, if you want the right margins of your staves aligned, you can
place a guide on the final barline of one system and stretch or
compress the other systems so that their final barlines are also
aligned to the Guide.

Horizontal Guides are useful for the alignment of text, dynamic
markings, crescendi and any other images that you want to be aligned
across the page.

Fig. 6.4: Horizontal Guides
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Chapter 7 - Advanced Input Methods
The standard method of adding images to the score is to type a
command on the keyboard and specify the placement of the image by
clicking the mouse button.  In addition to this input method, there are
a number of other ways in which images can be added to the score -
QuickScrawl  entry, On-screen Keyboard entry and Numeric Keypad
entry.  The Auto-Beam feature is also described in this chapter.

QuickScrawl
QuickScrawl is an extended mouse-entry method and are available at
all times. The purpose of QuickScrawl is to allow NoteWriter images
to be quickly drawn (or "scrawled") using the mouse as a drawing
tool.  Immediately after drawing, the scrawl is analysed and is
replaced by the desired NoteWriter image.  The advantage of
QuickScrawl is that the images can be quickly added to the document
without having to change the Current Command.

There are three QuickScrawl modes, each defined by the cursor used
- Pencil, Quill and Crayon.  To activate these modes, a particular key
is held down on the keyboard.

Key Depressed QuickScrawl Mode
Shift OR Caps Lock Pencil
Option Quill
Command ( ) Crayon

While one of these keys is held down, the cursor appears as the
suggested drawing instrument.  If the mouse button is depressed, a
line will be drawn on the screen as the mouse is moved.  When the
mouse button is released, the QuickScrawl drawing you have made is
matched against templates of possible NoteWriter images, and if
there is a match, the NoteWriter image is placed on the screen at the
location of the drawing.  Usually, the initial position of the drawing is
used to position the NoteWriter image.

Each of the three QuickScrawl modes is used to draw a particular
subset of NoteWriter images.  Since some QuickScrawls are used in
different modes to represent different images, it is important to
remember which categories of images are drawn by which cursor.
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The images are divided as follows:

Pencil Quill Crayon
Rests  Beams Dynamic Markings
Barlines Some Notes Articulation Markings
All Notes Ornaments
Flags Accidentals
Clefs

When using QuickScrawl it is important to think of this activity as a
kind of shorthand.  You are not really trying to draw the image
freehand, but rather are simply creating a series of line segments that
will be matched to the desired image’s template.  All "scrawls" are
reduced to a series of straight lines in one of the eight compass
directions (N, NE, E, SE, S, SW, W, NW).  To get accurate results,
keep your lines straight and as close to the compass directions as
possible.

N 

S 

E W 

SW 

NE NW 

SE 

Fig. 7.1: The Eight compass directions of QuickScrawl.

The procedure for adding an eighth note (with a downward flag) to
your score with QuickScrawl would be as follows:

• The command line, usually containing a commonly used symbol,
such as "q" for quarter note, is left unaltered.

• Ensure that you are in insert mode (the insert box should be
highlighted.)

• The Shift key is held down, and the cursor, which now resembles a
pencil, is moved to the starting position -- in this case, the third
staff space (from the bottom).

• The mouse button is then depressed and the mouse is moved in
the pattern which represents the eight note (South followed by
North-East as shown below).  It is important to try to keep the lines
as close to the 8 compass directions as possible.
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Figure 7.2:  A QuickScrawl Gesture

The length of the lines is unimportant since it is the sequence of
compass directions which is used for identifying patterns.  If
NoteWriter fails to find a match, the screen will remain unchanged
and the drawing may be repeated.  If an incorrect image is drawn, it
may be cleared with Undo.

In this case, as in the case of many NoteWriter images, the position
of the eighth note is adjusted to the Grid (assuming it is engaged) and
horizontally to the Vertical Alignment Bar (if it is on.)

Pencil Routines
The Pencil routines are the most commonly used.  You may find it
convenient to use the "Caps Lock" key (rather than holding down the
"Shift" key) if you are using QuickScrawl to enter a series of images.
(The "Option" and "Command" keys may still be used to activate the
Quill and Crayon with the "Shift" or "Caps Lock" keys down.)

Normally, the starting position of the Pencil (or the target cursor
before it is transformed into a Pencil) determines the location of the
NoteWriter image on the screen.  Rests and barlines will normally
default to the closest staff (provided Defaults are engaged) and notes
and rests will normally be drawn at the Vertical Alignment Bar (if it is
on).  Notes are all drawn at their standard length.  To get
non-standard note stems, the stem or flag must be altered with the
Adjust procedure after the image has been added.

Quill Routines
Quill routines are different from Pencil and most Crayon routines
Crayon routines because they are sensitive to the starting and ending
positions of the "Quickscrawl".  Normally, beams are drawn from the
beginning quill position to the final quill position regardless of how
many strokes have occurred between them.

In the case of all beams, NoteWriter decides whether a straight beam
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"b - type" or angled beam "a - type" is to be drawn by the location of
the starting and ending cursor positions.  Angles less than 10
degrees above or below the horizontal will be drawn as straight
beams others will be angled from the first to the second cursor
positions.

Both the Pencil and the Quill can be used for entering quarter notes
and flagged notes.

Crayon Routines
The Crayon is used to add dynamic indications, articulation markings,
ornaments and other specialized images.  The arpeggio, trill and
octava are drawn from the starting cursor position to the ending
position while all others are positioned according to the starting
cursor position (as in the case of Pencil routines).

A complete chart of QuickScrawl commands is provided in Appendix
2.  The chart shows the QuickScrawl pattern, the NoteWriter image it
represents, and information on where the starting cursor position
should be.  The fourth column lists the NoteWriter features which
affect the final position of the image:  the Grid, Defaults (if they are
enabled) and the Vertical Alignment Bar (if it is on).

On-screen Keyboard
NoteWriter provides an on-screen piano keyboard which may be
used to enter notes into the score.  Select Keyboard  ( -E) from the
Windows menu to make the keyboard visible.  In effect, the Keyboard
is a complex input controller.  In addition to adding notes to the score
the boxes in the Keyboard Window can be used to add or alter
accidentals, to adjust pitches, to add bar lines and to move the
Vertical Alignment Bar around the document.

In order to use the Keyboard to enter notes, the following steps must
be followed:
• The Keyboard Window must be visible.
• The Vertical Alignment Bar must be on -- notes are drawn on the

staff indicated by the V. A. Bar and at the location of the V.A. Bar.
If the V.A. Bar is not moved (by depressing the space bar or
clicking the arrows in the Keyboard Window), the next note will be
drawn at the same horizontal location.

• The image to be drawn must be entered as the Current Command.
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If there is no Command, or the Command is not a note, nothing will
be added to the score.

Remember, all input methods in NoteWriter may be used
interchangeably.  You may keep the Keyboard Window visible, and
still enter notes using other methods.  Also, the Keyboard controls
can be used to modify the last note entered (i.e. alter accidentals, add
dots etc.) regardless of the input method used.

Set Clefs
V.A. Bar

Stem Direction
Flip Stem

Remove Stem
V.A. Bar (Right/Left)

Add Barline
Add Dot

Shift Note Up/Down
Adjust Accidental Up/Down

Set Accidentals for Black Keys

Fig. 7.3:  Keyboard Window

Piano Keyboard
The central component of the Keyboard window is the 5 octave piano
keyboard.  When you depress the mouse button with the cursor on
one of the keys the corresponding pitch is sounded from the
Macintosh internal speaker and the note (indicated by the Current
Command) is entered on the score.  The volume of the sound can be
altered in the System Control Panel (under the Apple menu).

! Because of the changes to the Macintosh Sound Manager and to the
Macintosh System file, the keyboard may not sound on your computer.

Set Clefs
Since NoteWriter has no immediate knowledge of which clef is
associated with which staff, the clef must be set by clicking the
appropriate box.   All notes played on the keyboard are drawn on the
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current staff (which is determined by the Vertical Alignment Bar) at
the pitch relative to the specified clef.  In other words, if you play
middle C (which is the gray note on the keyboard) the note will appear
one line below the staff if the treble clef is selected, one line above the
staff if the bass clef is selected, on the middle staff line if the alto clef
is selected and on the second line if the tenor clef is selected.

Move Vertical Alignment Bar Up or Down
The up and down arrows shift the Vertical Alignment bar to the
previous or next staff in the score.  The new staff becomes the
current staff (i.e. the staff on which notes will appear), and the
document is adjusted so that the staff is visible in the window.

Set Stem Direction
There are three settings for stem direction.  The settings determine
which direction stems and flags will be drawn when notes are input.
The highlighted box indicates the current setting, which may be
changed by clicking one of the other boxes.  The three settings are:

• Default direction (above the middle line  - stems down, middle line
and below -- stems up)

• Force stems down (lower voice of a two part composition)
• Force stems up (upper voice of a two part composition)

Flip Stem Direction
Clicking the mouse in this box flips the direction of the stem or flag.
This procedure operates on the last image added to the score
(provided it is a note).

Remove Stem
Clicking this box causes the stem of the last image to be eliminated.
This feature can be used for chord clusters, where notes are placed
on either side of the stem.

Shift Vertical Alignment Bar Right and Left
There are four horizontal shift areas.  The thick arrows move the V.A.
Bar the distance set with the Set Alignment menu item.  The thin
arrows shift the Bar a distance of a single note width.  The main
purpose of the thin arrow is to shift the V.A. Bar to the other side of
the stem (for creating chord clusters).  The normal methods of
moving the V.A. Bar may also be used  (i.e. depressing the Space,
Tab or Back-quote keys.)
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Add Barline
This box causes a barline to be drawn at the position of the Vertical
Alignment Bar.  After drawing the barline, you should increment the
V.A. Bar to the right to allow some space between the barline and the
next note.

Add Dot
This box causes a dot to be added to the last image provided it is a
note.  To remove the dot, choose the Remove Modifiers item from the
Modify menu or the Remove Dot item from the Ext. menu.

Shift Note Up or Down
These two boxes cause the last note entered to be shifted up or down
in the score.  This is useful for error correction or for enharmonic
adjustments to notes.

Shift Accidental Up or Down
These two boxes cause the accidental associated with the last
entered note to be altered.  If there is no accidental, one will be
added.  The accidentals appear in a circular sequence as follows:

Shift Accidental Up 

Shift Accidental Down 
Fig.7.4:  Shifting Accidentals

Set Accidentals for Black Keys
Although not a complete enharmonic system, this table controls
which note and accidental appears when the black keys are played.
The five rows in the table each refer to one of the black pitch classes
(i.e. a pitch in all octaves) beginning with the C#-Db key.  The four
columns in the table indicate which note and accidental appears.  In
the case of C#, the choices are:

1) the note on C with no accidental
2) the note on C with a sharp accidental
3) the note on D with a flat accidental

Chapter 7: Advanced Input Methods    125

4) the note on D with no accidental

Normally, the current key signature (if there is one) is set by selecting
the the appropriate notes in the first or fourth columns.  Doing this will
stop accidentals that appear in the key signature from appearing.  The
example below shows the normal configuration for two different keys.
Notice that this table allows leading tone accidentals (e.g. F sharp in
G minor) to be set as well as the accidentals in the key signature.

Fig. 7.5:  Setting Key Signatures

� The Key Signature table does not accommodate keys with more that 5
accidentals.  Also, there is no mechanism for automatically adding
sharps or flats to the white piano notes.  These alterations must be
made with the Shift Accidental boxes.

Numeric Keypad Entry
Numeric Keypad entry is active at all times and may be used to enter
notes or to modify any notes added with other input methods.  As with
the On-screen keyboard, the Vertical Alignment Bar must be active
for notes to be added with Numeric Keypad entry.  The keys of the
numeric keypad have the following functions:

1) The Enter key is used as a shift key.

2) Numbers 1 through 9 are used to enter notes.  The note type is
determined by the Current Command and the number indicates the
diatonic interval above or (if the Enter key is held down) below the
previous note.  For example: 1 is a unison, 2 is a step above,
Enter-3 is a third below).  The initial starting position is the top line
of the staff.

Normally stem direction is determined by the pitch (with notes
above the middle staff line having stems down and notes below the
middle staff line having stems up.)  However, you may also use the
Stem Direction settings in the Keyboard window to force stems to
be drawn up or down.  When Auto-beam is active, notes will be
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grouped into beams as they are entered.

3) The "0"key adds a rest (at the position of the V.A. Bar) that is
equivalent to the note type specified by the Current Command -
(eg. if the Command is "q", a quarter rest will be added.)

4) The "." key adds a dot to the previous note (and increments the
V.A. Bar.)

5) The "+" key adds accidentals to the previous note.  The
accidentals are added by ascending semitones: natural - sharp -
double sharp unless the Enter key is held down in which case the
direction of the semitones is reversed: natural - flat - double flat.
This key can be used to modify notes added with any NoteWriter
input method.

6) The "-" key is used to jump back to the previous note.  This is
necessary when Automatic Increment is engaged and you want to
build chords within a single voice.

7) The "*" key is used to flip the stem direction of the previous note.

8) The "/" key is used to add barline at the position of the V.A. Bar.

9) The "=" key is used to eliminate the stem of a note (for building
chords.)  When the key is depressed a second time, the stem is
restored without a flag (if one previously existed).

10) The "clear" key acts as a carriage return.  It scrolls the document
back to the left edge of the page and moves the Vertical Alignment
Bar to the beginning of the next staff.
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Fig. 7.6:  Numeric Keypad

Auto Beaming
Auto Beaming is turned on with the Auto Beam item ( -1) in the
Control menu.  The beat size of the beam group is specified with the
Set Auto Beam... item in the Control menu
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Fig. 7.7:  Set Auto Beam Dialog

When Auto Beaming is active, the notes and rests you enter are
collected until a full beat has been entered.  At this time, the notes will
be formed into a beam group and the next group of notes and rests
collected.  Notes that are placed at the same horizontal location as
the previous note (i.e. in chords) will not be counted as new notes.

While using auto beaming, you can reset the beam counter (which
keeps track of the notes that should be included in the beam group)
by choosing the Reset Auto Beam item (  - 2) in the Control menu.
When a barline is entered or the Clear key (i.e. a carriage return) is hit
the beam counter is automatically reset.

If incorrect beaming occurs, you can select Undo to remove the
beam and choose Reset Auto Beam at the beginning of the next beat.

The Auto Beam feature is especially useful when used in conjunction
with Auto Increment and either the On-screen Keyboard or Numeric
Keypad entry.

! Auto Beaming should only be used for entering relatively simple
rhythmic material - it cannot accommodate triplets or other complex
groupings.  Remember to turn off Auto Beaming when you are not using
it or it may try to beam notes that you do not intend to be beamed.
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Chapter 8 - Other Features
Command List
The Command List... ( -F) item in the Windows menu displays an
extensive listing of NoteWriter commands along with the image they
draw.
Simply click on an image to automatically enter it as the Current
Command or click the Done button to close the window.  Refer to
Appendix 4 to see the images in the Command List.

Overview Window
The Overview feature (which is activated by the Show Overview...
( -F) item in the Windows menu) provides a reduced view of the
document.  The reduction factor depends on the size of the document
and the size of your screen, but the entire page will be displayed in
the Overview window.

The Overview window may be moved (by dragging the Title Bar) and
closed (by clicking the Go-Away box.)  As discussed in Chapter 5,
the visible portion (print area) of the document appears as a
highlighted rectangle in the Overview window.  You may indicate a
different print area by dragging this rectangle to a new location.

Changes that are made to the score while the Overview window is
visible are not updated in the Overview window.  However, the
changes will appear when the Overview window is redrawn (either by
re-selecting the menu item or scrolling to a different page.
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Fig. 8.1: Overview window

Change Page Size
To change the size of your page, select the Change Page Size item
from the Document menu.  A dialog box, which is similar to the Page
Set-up dialog box, appears and a new document size may be
specified by dragging the box in the grid or by typing the new values in
the Score Height and Score Width text boxes.  If you want to specify a
size larger than the sizes available with the grid (i.e. larger than 24" X
32"), enter the new size in the text boxes and click the Show Score
Size button.  You should also indicate whether you want all pages to
be altered or only the page that is currently visible.
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Fig. 8.2: Change Page Size Dialog Box

When you change the page size, the images in the document are not
altered.  If you widen the document, the right edges of staves will
have to be extended manually -- by selecting and adjusting them.  If
you lengthen the document, additional staves must be added
manually (either by copying and pasting existing staves or with the
"fst" command).  If you reduce the size of the document, you should
ensure that all images have been removed from the area being
eliminated.  Images left in this area are still considered to be part of
the document and may appear when the document is printed.

Other File Formats
As mentioned earlier, NoteWriter supports two file formats in addition
to NoteWriter format.  To save a document in another format, select
Save As... (from the File menu) and choose one of the three possible
formats
• NoteWriter format - used to save the current NoteWriter document

with a different name.
• PostScript format - used to save the document as a PostScript file

or in Encapsulated PostScript format for inclusion in page layout
programs or word processors.

• Paint format - used to save the current page as a bitmap in
MacPaint format.
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Fig. 8.3: Save As... Dialog Box

NoteWriter Format
Choosing Save ( -S) from the File menu will save the entire
NoteWriter document and all its attributes in standard NoteWriter
format.  It is recommended that you select Save regularly while
working to avoid losing your work through a system or program crash.

Selecting Save As... from the File menu and choosing the NoteWriter
Format button will allow you to save your file with a different name.
The original file will remain on disk as it was when you last saved it.

PostScript Format and Encapsulated PostScript
To save a document or a single page as a PostScript file or in EPS
format, select the Save As... item in the File menu and choose the
PostScript  Format button.  To save a portion of the page in EPS
format, select the area to be saved (with the Select-Rect or
Select-Region tools) and choose the Save Selection as EPS... item in
the File menu.

A series of dialog boxes allow you to set the various options for
saving your PostScript or EPS file.  You will first be asked to specify a
printing scale for your file.  This is the point size that the images will
be drawn at if no additional reduction or enlargement is performed.
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Fig. 8.5: Printing Scale Dialog Box

The chart below shows the possible point sizes and their equivalent
reduction / enlargement percentages:

16 point 67%
20 point 83%
24 point 100%
28 point 117%
32 point 133%
36 point 150%

Since most of the applications that accept EPS files have their own
facility for scaling, you may want to simplify the process by saving the
file at normal size (24 point.)  The excerpt can be scaled or resized
after it has been imported into the page layout or word processing
program.

After setting the page scale, you will be prompted to set the
Document Type as either an Encapsulation or as a PostScript file.
Encapsulations (which are in Encapsulated PostScript format) are
usually single page excerpts (or smaller) that are to be imported into
other graphics programs.  PostScript files are self-contained files
(which may include multiple pages) and which can be downloaded
directly to a PostScript printer.  Since PostScript files include the
PostScript code to print the page, they are not intended to be imported
into page layout programs - use Encapsulation to do this.
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� For those familiar with Macintosh file types, EPS files are of type EPSF
whereas PostScript files are of type TEXT.

If you have chosen to save a PostScript file, a dialog box will prompt
you to choose either This Page Only or Entire Document.  This Page
Only refers to the page that is currently visible.

Next, you will be asked whether you want to save a picture (in PICT
format) with the PostScript file.  The picture is a bitmap image of the
page (or the selected area if you have chosen Save Selection as
EPS...)  The picture is saved with the EPS file and will appear when
the EPS file is imported into a page layout or word processing
program.  If you are exporting the EPS file to a non-Macintosh
computer, there is no point saving the picture since the program will
not be able to display it.

Fig. 8.5: Save Picture dialog

Once these options have been set, you will be prompted to give the
PostScript file a name.  Be sure to give it a unique name so that you
do not accidentally write over an existing NoteWriter file.  As a
convention, you may want to give all PostScript files a suffix (e.g.
file.eps).

When saving a fragment of the score as EPS, only images whose
primary Control Point is within the selected area are sent to the file.
This means that staves are not included in the EPS file unless they
are included in the selection.  In some cases, you may want to add a
short staff on top of an existing staff so that the shorter staff will be
included in the file. For details on how to load EPS files into specific
page layout, word processor and graphics applications, refer to the
user’s manuals of these programs.

As an example, the procedure for combining a music excerpt with text
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in the PageMaker  program is as follows:

• Select the excerpt with the Select-Rect tool.  Include a staff in the
selection if you want a staff drawn.  All images whose first Control
Point is selected will be included in the PostScript file, and the
images will be clipped to the size of the rectangle.

• Choose the Save Selection as EPS item in the File menu and give
the file a new name.

• Open the PageMaker file you want to add the NoteWriter excerpt
to.

• Select the Place item in the PageMaker File menu and choose the
file you created in NoteWriter.  Once the file is loaded, the cursor
changes to indicate that a file in PostScript format is ready to be
added to the document.  Position the cursor at the location of the
top left corner of the encapsulated fragment and click the mouse
button.

• The fragment appears as a gray rectangle with the dimensions of
the original selection.  If a PICT has been saved with the file, it will
appear in the box.  If not, the title of the excerpt, the date and time
created and the creating application (i.e. NoteWriter) will appear in
the rectangle.

It is now possible to distort, crop, scale and adjust the position of the
excerpt using PageMaker’s standard editing procedures.  Other page
layout programs should operate in a similar fashion.

Paint Format
To save a single page in Paint format, select the Save As... item in
the File menu and choose the MacPaint Format button.  MacPaint
format is readable by many graphics applications and may be used to
create graphic scores or to cut and paste fragments (as bitmap
images) into many Macintosh word processors or graphics programs.

The procedure for doing this is:

• Save the score in Paint format and quit NoteWriter
• Open the graphics program (e.g. MacPaint, FullPaint ,

SuperPaint , Paint Cutter  etc.) and load the file you have saved
into the application.

• Copy the desired portions of the score and paste them into the
Scrapbook (in the Apple menu).
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• Quit the graphics application and open a text document on your
word processor.

• Paste the excerpts from the Scrapbook into the text document.

Since NoteWriter screen images are enlarged, a 6.75" X 7.75"
document will fill the 8" X 10" maximum size of the MacPaint file.
Because of this restriction, it is not possible to save larger areas as
Paint files.

� Paint format is rarely required since the Macintosh system provides a
mechanism for capturing screen images (  - Shift - 3).  However, if you
are working on a Macintosh computer with small screen, saving the
page in Paint format may still be useful.

� It is NOT possible to open either PostScript or Paint files in NoteWriter.
Remember to save your documents in NoteWriter format if you want to
open them later.

Working with Large Documents
NoteWriter allows tremendous flexibility in page size and format,
although orchestral-sized scores (because of their size) are
somewhat awkward to work with without a large screen.  The following
suggestions should make the creation of orchestral scores simpler.

Page Setup
• When setting up your initial page, specify the document size and

the distance between staves (which may be reduced in some
scores.)

• You may also want to leave a slightly larger left margin so that
instrument names can be added.

• You should decide how you want bar lines handled in the document
- either individually or in instrumental sections, and you should set
up the document appropriately.   To do this, specify Other as the
number of staves in a system and enter the staffs and braces as
you want them.

• Add clefs, key signatures, instrument names and barlines to create
a score template.  The template should saved to disk and can be
used for each section of the score, saving the document as a
different name each time.  This will save a substantial amount of
page setup time.  It is also possible to eliminate and re-position
staves to alter the page format as the number of instruments
changes.
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Entering the Material
• Working on the document is no different than working on a small

document, except that the small size of score window makes for a
great deal of scrolling.  It is advisable to use the Miniature Page in
the Scroll Window to move directly to other places in the
document, since sequential scrolling can be quite slow.

• When working though the score, you should enter the most
complex lines first, then place Vertical Guides at each beat or
sub-beat in this part.  The other voices can then be correctly
aligned to the Guides.  Alternatively, if the music is very simple,
you can use the Vertical Alignment bar (e.g. one increment of the
V.A. Bar for each eighth note).

• Use the global barline and time signature commands - the prefix
"&" to add these images on every staff on the page.

• You should examine the document periodically with the Show
Overview feature, and save the file regularly to disk.

Printing the Document
• If you are printing the document on a printer with a small page size

(e.g. the Apple LaserWriter), you can print a large document by
tiling (and piecing the fragments together), by reduction, or by a
combination of reduction and tiling.

• Alternatively, you can save the document in EPS format and load it
into a page layout program.  The entire document can then be
pasted onto a large page in the page layout program and printed on
a large-format laser printer or phototypesetter.  For example, a
score with dimensions of 15" X 22" can be loaded into a page
layout program and printed on a Linotronic L100 at 75% reduction
onto an 11" X 17" page.

Extracting Parts
NoteWriter does not have an automatic part extraction procedure.
However, parts may be created quite efficiently by cutting lines from
the score and pasting them into another file or into the Symbol Library.
For small scores, you can paste the parts onto successive pages in
the same document.  For large scores, parts should be copied and
saved in separate files.

The extracted files may be further edited, so that cues may be added
and multiple measures of rests eliminated.
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The procedure for extracting an instrumental part is as follows:

• Create a new "parts" document with single staves and the
appropriate clef and key signature.  The document should be the
same width as the original score.  It may be useful to use Save
As.... to save multiple copies of this template to disk so it can be
used for other instrumental parts. Close the "parts" document.

• Open the original score.
• Set the Select to Right Edge menu item in the File menu and copy

the first line of the score by placing the cursor immediately to the
right of the clef and selecting all the material on the staff (without
selecting the staff).  If you include material belonging to other parts,
it may be removed once the passage has been pasted into the
"parts" document. Make note of the first pitch of the selected
passage so you will have a reference when you paste the material
into your parts document.

• Choose New from the Library menu to create a new Symbol Library
and paste the copied material into a the first segment of the library.

• Continue copying lines of this instrument from the pages of the
score and pasting them into successive segments of the Symbol
Library.

• Once the all the lines of the instrument have been copied into the
Symbol Library, close the score and open the blank "parts"
document.

• Paste each segment of from the Symbol Library onto successive
lines of the "parts" document, dragging each to the correct location
(using the first pitch of each passage as a reference).

• Once all the lines have been pasted into the "parts" document, you
can add rehearsal letters, bar numbers, tempo indications, cues,
and replace multiple measures of rests with the "=" command.
Transposition can also be performed by selecting passages,
moving the notes up or down on the page and changing the
appropriate accidentals.  The Shift-Select editing procedure will
simplify this process.

• Save and Close the "parts" document and repeat the process for
the next instrument.

140   Chapter 8: Other Features 



Chapter 9 - Helpful Hints
Rearranging the Windows
NoteWriter windows are all moveable, so you may want re-position
them on the screen to reduce the amount of mouse activity during
image entry and editing.  To move a window, hold the mouse button
down with the cursor in the window’s title-bar or the small black
square ("handle") at the upper-left or lower-right corner of the window.

The way in which you arrange the windows depends upon the input
method you are using.  For example, if you are regularly using the
Image Palette and Keyboard, you may want to place both of these
windows at the bottom of the screen and move the Score Window
above them.  If you are using a large screen, you may also want to
keep the Overview window visible, or partially visible, at one side of
the screen.

Fig. 9.1:  Re-arranging the NoteWriter Windows

If a window becomes hidden by another window, you can bring it to
the front either by selecting its title-bar (if visible) or by selecting it
from the Windows menu. You can store the Window locations (along
with the Postscript settings) by selecting Save Preferences... from the
File menu.

Editing Hints
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Everyone who uses NoteWriter seems to develop their own style of
entering and editing images.  There is no right or wrong way of using
the program, but the suggestions below should make editing more
efficient.

• Use the Undo command frequently.  It is faster to remove an
incorrectly placed image (with Undo or -Z) than to try to adjust it.
Also, if you incorrectly paste onto or cut from the score, Undo the
change.

• It is faster to enter multiples of one image (e.g. notes), then go
back and add other images (e.g. beams and slurs).  When you do
this, you change the Current Command less frequently and entry
proceeds more quickly.

• It is possible to enter notes without accidentals, then return to the
passage and Shift-Select the notes that require accidentals or dots
and choose the appropriate item in the Modify menu.

• Look for repeated gestures in the score and use the Copy ( -C)
and Paste ( -V) routines as often as possible.  If you see a
sequence in the score, enter the first instance of the gesture (draw
all the notes, beams, slurs and articulations) and Copy and Paste
the entire gesture to create the second instance.  Remember, it is
very easy to adjust pitches, so even if you only have a repeated
rhythmic gesture, it is probably faster to make a copy of the
fragment and alter the pitches than to re-enter all the components
of the passage.  If you find that if a particular rhythmic group is
used extensively in a piece, you will find that it is faster to copy and
paste the fragment repeatedly than to enter each group separately.
The example below shows how copying, pasting and adjusting can
be used to create a similar passage in the score.
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1. Copy first measure 

2. Paste into second measure 

3. Adjust pitches 

9.2:  Copying and Pasting to Create Similar Gestures

• If the score requires complex rhythmic groups to be aligned, it is
easier to enter the pitches using the Vertical Alignment Bar, and
once the gesture is complete, to stretch or compress the group
(using the Stretch / Compress routines) to align the notes to the
beat.  If accurate spacing is required, then the Grid should be
disengaged during the adjustment.  In the example below, a group
of 7 is entered and compressed so that it aligns with a group of 4.
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2. Select notes and choose the 
Stretch / Compress menu item 

1. Enter equally spaced notes 

3. Drag (compress) until  
the beats are aligned 

Fig. 9.3:  Aligning Complex Rhythms

• Use the Select to Right Edge ( -7) and Select to Bottom Edge
( -8) settings whenever appropriate.  For example, if you need to
adjust a portion of a measure in an orchestral score, set the Select
to Bottom Edge item and all images to the bottom of the score will
be selected.

• Aligning the right margins of the score are best done after the page
has been completed.  Place a Vertical Guide on the bar line of the
longest systems, and stretch the shorter systems so that they are
aligned to the Vertical Guide.

• Use QuickScrawl for rests, barlines and dynamic markings (even if
you are not using the routines for other images).  These images
are easily scrawled and entering them this way saves you
continually altering the Current Command.

Creating Custom Symbols and Images
The flexible design of NoteWriter allows many types of non-standard
notation to be created.  To do this, you may have to design your own
graphic symbols  this can be done either with the NoteWriter graphic
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tools or by importing PICT images.

Designing Images in NoteWriter
The simplest method of adding specialized symbols is to use the
NoteWriter graphics tools (Draw-Rect, Draw-Oval, Draw-Line) or a
combination of NoteWriter images and graphics tools to create the
new symbol, and copy and paste it into a Symbol Library.  In future,
whenever you need the symbol, you can copy it out of the Symbol
Library and paste it into the new document.  The images below have
all been created by combining graphics tools and NoteWriter images:

Fig. 9.4:  Custom Symbols

Designing Images in a Graphics Program
If the graphics tools are not sufficient to create the symbol you need,
you can design the image in a Graphics program (such as SuperPaint
or ClarisWorks) and import the image (in PICT format) into
NoteWriter.  The easiest way to import the image is to have both
NoteWriter and the graphics program running at the same time.  You
should be able to select and copy the image (in the Graphics
program), switch to NoteWriter, and paste the image into NoteWriter.
When the PICT image is first pasted into NoteWriter it is represented
by a gray rectangle, and after the PICT is dragged into position, the
image is drawn.  The gray rectangle is drawn around the PICT image,
but it is not printed.  If direct copy and paste between applications is
not successful, you can copy the images into the Scrapbook and then
later paste them into NoteWriter.

Importing PICT Images
The procedure for importing PICT images is outlined below.  It is
assumed that both NoteWriter and a Graphics program are running
simultaneously (under MultiFinder or System 7.)

1 Create in the graphic image or symbol in a Graphics program (eg.
SuperPaint 3.0).  Select the area to be copied and choose the

Chapter 9: Helpful Hints    145

Copy item from the File menu.

2 In NoteWriter, choose Paste from the File menu

3 Place the mouse cursor in the inverted rectangle and drag the
PICT image into position.  The image will appear when the mouse
button is released.

Fig. 9.5:  Importing PICT images

The imported PICT can be moved by dragging the top-left corner of
the rectangle and it can be resized by dragging the bottom-right
corner.  When PICT images are resized, the image is stretched or
compressed to conform to the bounding rectangle.

146   Chapter 9: Helpful Hints 



Fig. 9.6:  A Resized PICT image

If you do not want the PICT graphics to be displayed, you can hide
them by choosing the Hide Text and PICT item from the Control
menu.

� It is not possible to include imported PICT images in EPS files, so if you
plan to encapsulate you score for printing from a page layout program
or word processor, you should avoid including PICT images in the
NoteWriter document.

Printer Errors
NoteWriter converts its data structure into PostScript code which is
then sent to the printer.  If an error is encountered during printing (i.e.
a PostScript error is generated), the page will not print, and
sometimes no error message will appear.  If this happens, you should
follow the procedure outlined below:

1 Check to see whether the data is being sent to the printer -- a light
should flash on your Printer during communication.  If the data is
not being sent to printer, check that the cables are correctly
connected and that the Chooser is set for the printer you are
using.

2 Save the document as a PostScript file (choose Save As... from
the File menu) and follow the instructions for saving a PostScript
file.  Try sending the PostScript file directly to the printer with a
Font Utility program (eg. LaserWriter Utility.).   If you get a
successful print using this method, you may want to load the
document into a page layout program and print the document from
the page layout program.  If you get a PostScript error while you
are downloading the file, then the NoteWriter document contains
some bad data.  This is normally caused by an incorrectly entered
image, and the only way of saving the file is to locate and remove
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the offending image.

3 To find an incorrect image, open the NoteWriter document and
examine the Control Points by selecting Show Control Points from
the Control menu.  See if there are any extraneous Control Points
(i.e. Control Points which do not seem to belong to any image) and
erase them from the document.

4 If the document still does not print, try copying portions of the
document, and pasting them into a new page, and printing the
document in pieces.  This should help determine which image is
causing the error.  The following images or situations have been
known to cause memory errors in large documents.

• Excessively large text boxes of any style
• Text boxes (especially with long lines of text) that have Outline or

Shadow styles.)
• Too many different fonts and styles of text
• documents with images below the bottom margin
• some graphic images, especially if they have no dimensions (i.e.

they were drawn on one point) or they are reversed (i.e. the
second control point is to the left of the first.)

•  multiple measure rests images that are too short to be visible on
the page or that were added without a number in them.
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Appendix 1 - Menus
Menu
About NoteWriter...

Displays version and copyright information.

File Menu
New  -N

Create a new NoteWriter document by launching the Page
Setup dialog boxes.

Open... -O
Open an existing NoteWriter document for editing.

Save -S
Save the open NoteWriter document onto disk (using its current
file name).

Save As...
Save the open NoteWriter document onto disk in either
NoteWriter format with a new name, in Encapsulated PostScript
format or in Paint format.

Close
Close the open NoteWriter document.  You will be prompted to
save changes if you have not already done so.

Draft Print @ 75%
When the item is checked, the print size of Draft printing is
automatically reduces to 75%.

Draft-quality Print...
Print the document using the QuickDraw screen images on a
dot-matrix or non-PostScript laser printer.

Laser Print... -P
Print the document using Sonata font and PostScript graphics
on a PostScript laser printer or phototypesetter.

Page Setup...
Calls the page setup dialog of the currently chosen printer.  This
allows options such as page layout, print reduction and paper
size to be set.

Save Selection as EPS...
Save the currently selected area of the page in Encapsulated
PostScript (EPS) format.

Save Preferences...
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Save the window positions and current PostScript settings in a
preference file.

Quit -Q
Quit the NoteWriter program.  You will be prompted to save the
document if you have not already done so.

Edit Menu
Undo  -Z

Undo the last change made to the document.

Cut  -X
Remove the images from the selected area and save them in
the NoteWriter buffer.

Copy  -C
Copy the images from the selected area and save them in the
NoteWriter buffer.

Paste  -V
Paste the contents of the NoteWriter buffer onto the screen so
that the images can be dragged to the desired location.

Clear
Delete all images which have their primary Control Point in the
selected area.

Move
Move (by dragging) all images which have their primary Control
Point in the selected area.

Adjust
Adjust (by dragging) the position or dimensions of all images
which have a Control Point in the selected are

Stretch / Compress -K
Stretch or compress (by dragging) the horizontal positions of
images within the selected area.

Justify -/
Horizontally adjust the positions of selected images so that the
music fits properly on the staff.

Select to Right Edge -7
Make the selection box extend to the right edge of the
document.

Select to Bottom Edge -8
Make the selection box extend to the bottom edge of the
document.
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Remove Last Image -9
Remove the last image added to the document.

Reinstate Last Image -0
Reinstate images that have previously been removed with
Remove Last Image.

Set Edit Filter...
Allows you to set the types of images that will not be selected in
cut, copy and clear operations.

Clear Edit Filter...
Clears the Edit Filter settings.

Modify Menu
Beam Notes -B

Beam all notes in the selected area.
Un-Beam Notes -H

Removes the beams from notes in the selected area.
Flip Beam or Tie -I

Changes the beam drawing direction and the tie drawing
direction in all selected beams, ties and slurs.

Transpose  Free Transpose -U
Transpose (by dragging) the selected notes.

Transpose  Transpose Interval...
Transpose the selected notes by a specified interval.

Transpose  Transpose Key...
Transpose the selected notes from one key to another.

Transpose  Clean Up Accidentals
Adjusts accidentals in the selected area to remove repeated
accidentals.  This command should be used after transposition.

Previous Staff
Change the staff association of selected notes to the staff
immediately above their current staff.  Ledger lines will be drawn
to the new staff.

Next Staff
Change the staff association of selected notes to the staff
immediately below their current staff.  Ledger lines will be drawn
to the new staff.

Remove Ledgers - -
Remove ledger lines from selected notes.  The notes are not
longer associated with any staff.
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Add Ledgers - =
Add ledger lines to selected notes.  Each note becomes
associated with the closest staff and ledger lines are drawn to
that staff.

Note Modifiers  Remove Modifiers -M
Remove all accidentals and dots from selected notes and all
dots from selected rests.

Note Modifiers  Add Double Sharp
Add a double sharp (in standard position) to all selected notes.

Note Modifiers  Add Sharp -3
Add a sharp (in standard position) to all selected notes.

Note Modifiers  Add Natural -2
Add a natural (in standard position) to all selected notes.

Note Modifiers  Add Flat -1
Add a flat (in standard position) to all selected notes.

Note Modifiers  Add Double Flat
Add a double flat (in standard position) to all selected notes.

Note Modifiers  Add Dot
Add a dot to all selected notes and rests.

Note Modifiers  Shift Accidental Left
Shift the horizontal position of the accidentals on all selected
notes to the left (so that the accidental is farther from the
notehead.)

Note Modifiers  Shift Accidental Right
Shift the horizontal position of the accidentals on all selected
notes to the right (so that the accidental is closer to the
notehead.)

Note Modifiers  Add Staccato -.
Add a staccato mark above or below all selected notes.

Note Modifiers  Add Accent -A
Add an accent mark above or below all selected notes.

Note Modifiers  Add Accent -[
Add a tenuto mark above or below all selected notes.

Note Values  Change to Quarters
 Change all selected notes to quarter notes.

Note Values  Change to Eighths
 Change all selected notes to eighth notes.

Note Values  Change to Sixteenths
 Change all selected notes to sixteenth notes.
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Note Values  Double Note Values
 Change all selected notes to double their rhythmic values.

Note Values  Halve Note Values
 Change all selected notes to one half their rhythmic values.

Tie Notes -T
Draw a tie between the first two selected notes.

Flip Notes -F
Flip the beams and stems of selected images so they are drawn
on the other side of (i.e. above or below) the notehead.

Control Menu
Text Format... -W

Set the text font, font size, style and justification in the Text
Format dialog box.

Alignment -L
Turn the Vertical Alignment bar on or off.

Ruler -R
Turn the On-screen Ruler on or off.

Grid -G
Turn the Grid on or off.

Defaults -D
Turn Defaults on or off.

Auto Increment -Y
Set the Vertical Alignment Bar to move forward when a note or
rest is entered.

Auto Beam -1
Groups notes into beams as they are entered.

Reset Auto Beam -2
Clear the collection of notes for beaming.

Set Auto Beam...
Set the size of the rhythmic group for auto beaming.

Set Alignment...
Set the size of the increments of the Vertical Alignment Bar.
These settings control the distance that the bar shifts when the
Space and Tab keys are depressed.

Set Line Width...
Set the width of lines and the method (i.e. fill, frame, erase) of
drawing rectangles and ovals.

Set Stem Clip...
Set how stems are clipped by beams when beams are added
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manually to the score.
Set Rulers...

Set whether the rulers (and other measurement units) should be
inches or centimeters.

Show / Hide Control Points
Show or hide the Control Points for all images.  Primary Control
Points are drawn in white, others in gray.

Hide / Show Text and PICT
Hide or show the text boxes and imported PICT images.

Hide / Show Print Area
Hide or show (as a gray rectangle) the area of the page that will
be printed with the current page setup.

Hide / Show Text Frame
Hide or show the gray frame around text boxes.

PostScript  Settings...
Set the beam thickness, the distance between beams and the
default line thickness.

Document Menu
Add Page

Add a page after the current page to the open document.
Delete Page

Delete the current page from the open document.  (This
operation cannot be undone.)

Insert Page
Add a page before the current page to the open document

Go To Page...
Jump to the specified page in the open document.

Change Page Size
Change the page size of the current page or the entire
document.

Library Menu
New Library

Creates a new (blank) Symbol Library.
Open Library...

Allow you to select and open a Symbol Library from disk.
Save Library

Saves the open Symbol Library to disk.
Save Library As...
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Saves the open Symbol Library to disk under a new name.

Windows Menu
Score Window -\

Brings the Score Window to the front of the screen.
Show Overview -F

Brings the Overview Window to the front of the screen and
draws a miniature version of the page in the window.

Command List... -‘
Displays a complete list of all NoteWriter commands.

Palette Window
Brings the Palette Window to the front of the screen.

Scroll Window
Brings the Scroll Window to the front of the screen.

Command Window
Brings the Command Window to the front of the screen.

Keyboard Window -E
Brings the Keyboard Window to the front of the screen.

Symbol Library
Brings the Symbol Library Window to the front of the screen.

Ext. Menu
Remove Dot

Removes dots from selected notes and rests.
Remove Accidental

Removes only the accidental from selected notes.  (The
Remove Modifiers menu item removes both accidentals and
dots.)

Remove Stems
Removes the stems from notes.

Remove Heads
Removes the noteheads from selected notes (leaving only the
stem.)

Change Note->diamond
Changes regular noteheads to a diamond noteheads on
selected notes.

Change Tie->dotted
Changes selected ties or slurs to a dotted curves.

Change Note->small
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Changes selected regular-sized notes to grace notes.

Align horizontal
Align selected images horizontally (to the first image in the
selection.)

Tie Middle Up
Adjusts the arc of the tie so it is higher.  In fact, the tie is
transformed into a slur and the middle point is adjusted.

Tie Middle Down
Adjusts the arc of the tie so it is lower.  As above, the tie is
changed into a slur and the middle point is adjusted.

Move 1Pix->right
Moves selected images 1 pixel to the right.

Move 1Pix->left
Moves selected images 1 pixel to the left.

Move 1Pix->down
Moves selected images 1 pixel down.

Move 1Pix->up
Moves selected images 1 pixel up.

Line Width...
Brings up a dialog box which allows the width of selected lines
and other graphics (rectangles, ovals, curves) to be altered.

Text...
Allows the characters in selected single-quote text to be altered.
(Up to 8 characters are allowed in single-quote text.)

Text Size...
Allows the size of selected single-quote text to be altered.

Time Signature
Allows selected time signatures to be altered.

Change Object
Allows the ID number of selected images to be altered.  This
should only be done by expert users!

Cresc.<->Dim.
Alters the direction of selected crescendi and diminuendi.
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Appendix 2 - QuickScrawl
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Crayon Routines
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Appendix 3 - NoteWriter Images
Command Image  Modifiers Mouse Clicks
Notes
dw double whole note . sh n fl 1 note head
w whole note . sh n fl 1 note head
h half note . sh n fl 2 note head--end of stem
q quarter note . sh n fl 2 note head--end of stem
e eighth note (flag) . sh n fl 2 note head--end of flag
s sixteenth note (flag) . sh n fl 2 note head--end of flag
ts thirty-second note (flag) . sh n fl 2 note head--end of flag
sft sixty-fourth note (flag) . sh n fl 2 note head--end of flag
q1 notehead (no stem) . sh n fl 1 note head
gw grace whole note . sh n fl 1 note head
gh grace half note . sh n fl 2 note head--end of stem
g grace quarter note . sh n fl 2 note head--end of stem
G grace quarter note (large) . sh n fl 2 note head--end of stem
ge grace eighth note (flag) . sh n fl 2 note head--end of flag
gs sixteenth note (flag) . sh n fl 2 note head--end of flag
gt thirty-second note (flag) . sh n fl 2 note head--end of flag
dia diamond (harmonic) . sh n fl 2 note head--end of stem
sdia solid diamond . sh n fl 2 note head--end of stem
+ x-note . sh n fl 2 note head--end of stem
qq quarter note (fixed stem) . sh n fl 2 note head--end of stem
hh half note (fixed stem) . sh n fl 2 note head--end of stem
gf grace note (8th flag) 1 note head
gfd grace note (16th flag) 1 note head
gft grace note (32nd flag) 1 note head
gfs grace note w/ slash (8th flag) 1 note head
gfds grace note w/ slash (16th flag) 1 note head
gfts grace note w/ slash (32nd flag) 1 note head
g( grace note head in brackets 1 note head
sm stem 2 top--bottom of stem

Flags
sflag single flag 2 base--top of flag
dflag double flag 2 base--top of flag
tflag triple flag 2 base--top of flag
qflag quadruple flag 2 base--top of flag

Rests
rw whole rest . 1 2nd staff line
rh half rest (dotted half) . 1 centre staff line
rq quarter rest . 1 centre staff line
re eighth rest . 1 centre staff line
rs sixteenth rest . 1 centre staff line
rts thirty-second rest . 1 centre staff line
rsf sixty-fourth rest . 1 centre staff line
rw- whole rest with staff line . 1 centred
rh- half rest with staff line . 1 centred
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Clefs
tc treble clef 1 centre staff line
ac alto clef 1 centre staff line
tnc tenor clef 1 centre staff line
bc bass clef 1 centre staff line
!tc small treble clef 1 centre staff line
!ac small alto clef 1 centre staff line
!tnc small tenor clef 1 centre staff line
!bc small bass clef 1 centre staff line

Accidentals
dsh double sharp 1 centred
sh sharp 1 centred
n natural 1 centred
fl flat 1 centred
dfl double flat 1 centred
fl1 1/4 flat 1 centred
sh1 1/4 sharp 1 centred
sh3 3/4 sharp 1 centred
!dsh 3/4-size double sharp 1 centred
!sh 3/4-size sharp 1 centred
!n 3/4-size natural 1 centred
!fl 3/4-size flat 1 centred
!dfl 3/4-size double flat 1 centred
gds grace note double sharp 1 centred
gsh grace note sharp 1 centred
gn grace note natural 1 centred
gfl grace note flat 1 centred
gdf grace note double flat 1 centred
. (...) dot (or multiple dots) 1 first dot centred

Beams
b beams (straight) # . , 2 start--end
a beams (angled) # . , 2 start--end
gb grace beams (straight) # . , 2 start--end
ga grace beams (angled) # . , 2 start--end
bb beams (below notes) # . , 2 start--end
aa angled beams (below) # . , 2 start--end
gbb grace beams (below) # . , 2 start--end
gaa angled gr. beams (below) # . , 2 start--end
sb single beam (straight) 2 start--end
sa single angled beam 2 start--end

Barlines
bl barline 1 top staff line
dbl double barline 1 top staff line
|. repeat beginning 1 top staff line
.| repeat ending 1 top staff line
&bl global barline (all systems) 1 horizontal position
&dbl global double barline (all staves) 1 horizontal position
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&|. global repeat beginning (all staves) 1 horizontal position
&.| global repeat ending (all staves) 1 horizontal position

Ledger lines
l ledger lines up # 1 top staff line
ld ledger lines down # 1 bottom staff line

Ties and Slurs
slur slur -- over / under notes 3 start--top of arc--end
tie tie -- over / under notes 3 start--direction--end
cur curve -- over / under notes 3 start--top of arc--end

Dynamic Markings
f forte (f) 1 centred
ff fortissimo (ff) 1 first letter centred
fff triple forte (fff) 1 first letter centred
ffff quadruple forte (ffff) 1 first letter centred
fp forte piano (fp) 1 first letter centred
mf mezzo forte (mf) 1 first letter centred
mp mezzo piano (mp) 1 first letter centred
p piano (p) 1 centred
pp pianissimo (pp) 1 first letter centred
ppp triple piano (ppp) 1 first letter centred
pppp quadruple piano (pppp) 1 first letter centred
sf sforzando (sf) 1 first letter centred
sfz sforzando (sfz) 1 first letter centred
< hairpin (cres. or decres.) 2 point--end

Time Signatures
#/# time signatures (e.g. 4/4) 1 centre staff line
1-9 numbers 1 first number centred
c common time 1 centre staff line
c/ cut time 1 centre staff line
&#/# global time signatures 1 horizontal position
&c global common time 1 horizontal position
&c/ global cut time 1 horizontal position

Staves
st staff 2 start, top of staff--end
!st narrow staff 2 start, top of staff--end
fst full length staff 1 top staff line

Articulation Marks
> accent (thin) 1 centred
>> accent (thick) 1 centred
_ tenuto 1 centred
_ . tenuto with dot below 1 centred
. _ tenuto with dot above 1 centred
^ accent-point up 1 centred
^^ accent-point down 1 centred
‘ staccatissimo (above) 1 centred
‘‘ staccatissimo (below) 1 centred
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. (...) dot (or multiple dots) 1 first dot centred
ferm fermata above notes 1 centred
fermu fermata below notes 1 centred

Other Symbols
sl slash up or down (45o) 2 start--height
$ signa 1 centred
coda coda sign 1 centred
oct octave 2 start--end of line
tr trill 2 start--end of wave
[ upper tuplet bracket # 2 start--end
] lower tuplet bracket # 2 start--end
, comma (breath mark) 1 centred
lv laisser vib. (lv) 1 centred
turn turn 1 centred
mord mordent 1 centred
o natural harmonic (o) 1 centred
ub up bow 1 centred
db down bow 1 centred
/ single tremolo 1 centred
// double tremolo 1 top tremolo is centred
/// triple tremolo 1 top tremolo is centred
ped pedal indication 1 centred
* pedal up sign 1 centred
arp arppeggio indication 2 top--bottom
gtr guitar tablature 1 centred
’.... text 1 bottom of first char.
{ piano brace 2 top--bottom
( straight brace 2 top--bottom
r# measure number # 1 centred
R... rehearsal number 1 centred
ks# sharp key signature # 1 B-line of staff
kf# flat key signature # 1 B-line of staff
&ks# global sharp key signature # 1 B-line of staff
&kf# global flat key signature # 1 B-line of staff

Lines
| vertical line # 2 top--bottom
|| vertical line-broken # 2 top--bottom
- horizontal line # 2 start--end
-- horizontal line-broken # 2 start--end
\ line - any direction # 2 start--end
x erase horizontal line 2 start--length of erase
y erase vertical line 2 top--length of erase
xy erases a straight line 2 start point--end point

Other Tips
Return Key Toggles between Insert and Select-rect modes
Shift Key Constrains horizontal movement when drawing
Option-Shift Constrains vertical movement when drawing
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Index

A
About the author
Accent menu item
Accidentals

add to notes
Add Articulations
Add Ledgers
Add Page menu item
Adjusting Images
Adjust menu item
Align horizontal
Alignment aids
Articulations
Auto-Beaming

B
Backups
Barlines
Beam Notes menu item
Beams

complex
setting stem clip
short
simple
single

Brackets for tuplets

C
Change

cresc to dim.
image code
note to gracenote
note to diamond
note values
page size
page size dialog
tie to dotted slur
to eighth notes
to quarter notes
to sixteenth notes

Chords
Clean Up Accidentals
Clear Edit Filter
Clefs
Command list
Command window
Complex rhythms
Control points

10
96
47
95
96
95
24
78
85
98

111
51

128

12
50
90
56
58
59
58
56
59
60

99
99
98
98
96

107
132

98
96
96
96
53
94
89
46

131
28

143
43
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placement for notes
selection

Copy
Copyright notices
Crayon routines
Cursors
Curves
Custom Symbols and Images
Cut

D
Default settings
Defaults
Delete images
Delete Page menu item
Document Setup

adding clefs
adding staves
grouping staves
remove staves
setting up
setting up multiple pages

Dot-matrix printing
Double Flat menu item
Double Sharp menu item
Draft printing
Drawing images overview
Dynamic indications

E
Edit filter
Edit menu
Editing hints
Editing overview
Erase
Eraser tool
Extension menu
Extracting instrumental parts

F
File Formats

Encapsulated PostScript
NoteWriter
PostScript
Paint

Flags
Flat menu item
Flip

beam direction
beams
stems
tie direction

55
79
82

5
122

29
65

144
83

42
112

83
24

26
25
26
26
23
24

103
95
95

103
33
46

89
82

141
34
84
30
98

139

133
134
134
134
137

56
95

91
97
97
91
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Font requirements

G
Global commands
Go to page... menu item
Graphics

designing in NoteWriter
designing in other programs
entering
importing
importing and placing
tools

Grid
Grid
Guides (vertical and horizontal)

H
Hamel, Keith
Hard Drive installation
Hardware requirements
Horizontal guides

I
Image palette
Images

adding to score
command list
complete list of
double click
single click
triple click

Importing Graphics
Insert Page menu item
Insertion cursor

J
Justify

K
Key Signatures
Keyboard (on-screen)

L
Large documents
Laser printing
Ledger lines

add
automatic
change staff association
manual
remove

Libraries
Lines

18

52
24

144
144

71
72

145
30
41

112
115

10
17
11

115

31

41
167
163

53
45
65
72
24
40

87

48
122

138
104

95
54
95
49
95
19
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changing width
entered with line tool
erasures
simple

M
Macintosh software license
Menu list
Modify menu
Modifying images
Move images 1 pixel
Move menu item

N
Natural menu item
Next Staff
Notes
NoteWriter

basic operations
file format
icons
system design

Numeric keypad entry

O
On-screen Keyboard
Opening the program
Opus 1 Music Inc.
Overview

Show Overview menu item
Oval tool

P
Page

Add Page menu item
change size
change size dialog
Delete Page menu item
Go to page... menu item
Insert Page menu item
set size

 setup
Paint format
Paste
Pencil routines
PICT images

designing in graphics programs
importing

PostScript
EPS format
errors
file format

99
30
60
60

9
149

90
90
98
85

95
95
53

20
134

18
12

126

122
21

5
11

131
30

24
107
132

24
24
24
23

102
137

84
121

145
145

134
147
134
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saving files
settings

Preferences
Previous Staff
Print the document
Printer examples
Printing

draft-quality
errors
large pages

 laser-quality
methods
modes

Q
QuickScrawl

crayon routines
pencil routines
quill routines
reference list

Quit the program

R
Rectangle tool
Reinstate Last Image
Remove

accidental
dot
heads
last image
ledgers
modifiers
stems

Rests
Ruler

S
Save the document
Save As... menu item
Scroll window
Select-Rect tool
Select-Region tool
Selecting Images

making large selections
Set Auto-Beam
Set Edit Filter
Set Line Width
Setting the command
Sharp menu item
Shift-Selecting
Slurs
Software license

109
107

19
95
36
14

103
147
106
104

13
101

119
122
121
121
157

37

30
88

98
98
98
88
95
95
98
45

111

35
134

32
29
29
77
88

128
89
71
39
95
80
65

6

Index    173

Software requirements
Sonata Font

in text boxes
Staccato menu item
Staff format
Stretch / Compress
Symbol library

copy and pasting

T
Tenuto menu item
Text

boxes
format
single quote  type
changing size
changing text
tool

Ties
adjust middle down
adjust middle up
make dotted

Tie Notes menu item
Tiling pages
Time signatures

altering
Tools

insertion tool
select-Rect tool
select-Region tool
text tool
eraser tool
graphics tool
vertical and horizontal guide tools

Transpose
by interval
by key
cleaning accidentals
free transpose

Tuplet brackets

U
Unbeam Notes menu item
Undo
Upgrades

V
Vertical Alignment Bar (V.A. Bar)
Vertical Alignment Bar
Vertical guides

W
Windows

11
18
70
96
25
86
74
74

96

68
68
48
99
99
30
65
98
98
98
96

106
49
99

29
29
29
30
30
30
31
92
93
93
94
92
60

90
82
12

41
113
115
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rearranging
Working with large documents

page setup
entering the document
printing the document
extracting parts

X
Y
Z

141
138
138
139
139
139
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